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is Manual and Workflow Overview

nline manual will help you install and use the KODAK PROFESSI
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WS driver to print, the port monitor 
river(s) must be installed on the 
talling the printer drivers on the 
g This Manual and Workflow Overview
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0 Digital Photo Print System Workflow 

 

Client Systems
 systems represent client systems in the ML-500 

low. They are networked to the server that is 
cted to the ML-500 printer. If you will be using the 
0 WINDOWS printer driver to print, the driver must 
talled on the clients.

The system conn
considered the s
are installed on t
ML-500 WINDO
and the printer d
server before ins
client systems.
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System RSyst
Utili

✔

✔

✔

✔

✔

e ML-500 Utilities

ng the ML-500 Utilities for the first 
DAK PROFESSIONAL ML-500 

nt System CD (see page 3) that 
h your ML-500 system.

re in the following order:
ilities 
r (see page 7)
ers (see page 10)
tem Requirements and Installation

Back Indexnts Next

equirements and Installationem Requirements (ML-500 
ties)

800 MHz PENTIUM III processor with 
minimum 512 MB of memory
WINDOWS 2000 Professional (Service Pack 
2, or latest), WINDOWS 2000 Server (Service 
Pack 2, or latest) with Services for 
MACINTOSH installed, WINDOWS 2000 
Advanced Server (Service Pack 2, or latest) 
with Services for MACINTOSH installed, or 
WINDOWS XP Operating Systems
Color monitor with an 800 x 600 pixel 
resolution
OHCI compliant IEEE 1394 card and IEEE 
1394 cable for connecting to printer included
A minimum of 10 GB available storage on 
hard drive

Installing th

If you are installi
time, use the KO
Digital Photo Pri
was included wit

Install the softwa
✔ ML-500 Ut
✔ Port Monito
✔ Printer Driv
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Upgr
Utiliti

Unins

If you 
Utilitie
versio
1. Fr

se

2. Se

3. Re
Pr
po

d Installing the ML-500 Utilities 
eb Site

s for the ML-500 printer can be 
DAK web site.
lowing Web site: 
dak.com/global/en/service/softwar
00Software.jhtml.

ctions on the screen for 
 and installing the software.
tem Requirements and Installation

Back Indexnts Next

ading to a New Version of the ML-500 
es

talling a Previous Version

are upgrading to a new version of the ML-500 
s, you must first uninstall the previous 
n. You can then install the new version.
om the Start menu select Settings, then 
lect Control Panel.

lect Add / remove programs.

move the previous version of the ML-500 
int Utilities. (It is not necessary to uninstall the 
rt monitor or printer drivers.)

Downloading an
from the Kodak W

Software update
found on the KO
1. Go to the fol

http://www.ko
e/ML500/ml5

2. Follow instru
downloading

http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml
http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml


Sys

Conte 3

Insta

1. Ch
Di
ap

2. In

3. Se

 screeen listing all software 
 on the ML-500 Software CD 

p of this screen you can select 
ntation or Additional Support for 
rmation.
 Utilities to launch the installation 

 warns you to quit other open 
tem Requirements and Installation

Back Indexnts Next

lling the ML-500 Utilities from the CD

oose the KODAK PROFESSIONAL ML-500 
gital Photo Print System CD with the 
propriate language.

sert the CD in your CD drive.

lect a language.

The Software
components
appears.

NOTE: At the to
Docume
more info

4. Click Printer
wizard.
A dialog box
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ap
so
O

5. Cl

6. Cl

mer Information screen, enter your 
nd company name. Click Next.
u must enter both your user name 

d company name before you can 
tinue.
se Destination Location screen, 
 install the Utilities in C:\Program 
ML-500\Utilities\ or click Browse, 
r folder, then click Next to install 
 the selected folder.
tem Requirements and Installation

Back Indexnts Next

plications and disable virus protection 
ftware. Follow those instructions then click 

K. 

ick Next on the Welcome screen.

ick Yes on the License Agreement screen.

7. On the Custo
user name a

IMPORTANT: Yo
an
con

8. On the Choo
click Next to
Files\Kodak\
select anothe
the Utilities in
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9. Cl
Fi

uirements (Port Monitor 
Drivers)

 is installed on the server system. 
stem requirements for the port 
ame as for the ML-500 Utilities. 

ter drivers, your client system must 
g minimum hardware and 

00/XP Operating Systems

ENTIUM III processor with a 
f 256 MB of memory
 2000 (Service Pack 2, or latest), 
 2000 Server (Service Pack 2, or 
DOWS 2000 Advanced Server 

ack 2, or latest) or WINDOWS XP
itor with an 800 x 600 pixel 
tem Requirements and Installation

Back Indexnts Next

ick Next on subsequent screens then click 
nish on the final screen.

System Req
and Printer 

The port monitor
Therefore, the sy
monitor are the s
See page 1.

To install the prin
have the followin
software:

WINDOWS 20

✔ 350 MHz P
minimum o

✔ WINDOWS
WINDOWS
latest), WIN
(Service P

✔ Color mon
resolution
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WIND

✔

✔

✔

 Operating System

ENTIUM III processor with 64 MB 

 NT 4.0 Workstation with Service 
r latest) or WINDOWS NT 4.0 
 Service Pack 6a

itor with an 800 x 600 pixel 

sing the WINDOWS printer drivers 
print, you must install the port 
nitor and the drivers on the server 
tem, then share the printer drivers 

h the client systems.
tem Requirements and Installation

Back Indexnts Next

OWS 98/ME Operating Systems

350 MHz PENTIUM III processor with 64 MB 
of memory
WINDOWS Millennium or WINDOWS 98 
Second Edition
 Color monitor with an 800 x 600 pixel 
resolution 

WINDOWS NT

✔ 350 MHz P
of memory

✔ WINDOWS
Pack 6a (o
Server with

✔ Color mon
resolution 

IMPORTANT: If u
to 
mo
sys
wit
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MAC

✔

✔

✔

✔

IMPO

e Port Monitor and 

ur printer are ML-500 Drivers for 
e, WINDOWS NT 4.0, WINDOWS 
CINTOSH Operating Systems. 

you will be printing from client 
tems to the ML-500 printer, you 
st first install the port monitor and 
nter driver(s) on the server system 
e same computer the Printer 
lities were installed on). You must 
o share the printer driver(s) with 
 client system(s).
“ML-500 Digital Photo Print System 
” at the beginning of this manual 
cription of client and server 

t a Source folder has been created 
e 44) before installing the port 
tem Requirements and Installation

Back Indexnts Next

INTOSH Operating System

300 MHz G3 processor or higher
128 MB of memory or higher
MAC OS 10.2.3 or higher
(OS 10.2.3 or higher is required to use the 
Custom Paper Size panel.)
Color monitor with 800 x 600 pixel resolution 
or higher
RTANT: WINDOWS 2000 Server or 

WINDOWS 2000 Advanced Server is 
required for sharing the Source Folder 
using File Services for MACINTOSH 
with the APPLETALK Protocol.

Installing th
Drivers

Provided with yo
WINDOWS 98/M
2000/XP and MA
IMPORTANT: If 

sys
mu
pri
(th
Uti
als
the

NOTE: Refer to 
Workflow
for a des
systems.

NOTE: Verify tha
(see pag
monitor.
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Install
order:
1. In

Th
W

2. In
se

3. If 
W
NT
dr
cli

4. In
(s
(s

ort Monitor on the Server

t monitor sends print jobs to the 
en printing from a printer driver. 
 must be installed on the server 

Source folder has been created 
) before installing the port monitor.
lder does not exist, start the Print 
ation (see page 41) and a Source 

 automatically created in the default 
-500 Source Folder).
you don’t do this, you will not be 
le to complete step 12.
DAK PROFESSIONAL ML-500 
 Print System CD.

uage.

onitor to display the Print Server 
reen.

rt.
tem Requirements and Installation

Back Indexnts Next

 the port monitor and drivers in the following 

stall the port monitor on the server system.
e server must be WINDOWS 2000 or 
INDOWS XP.

stall the WINDOWS 2000/XP driver on the 
rver system (see page 10).

the client operating system is Windows 98, 
INDOWS Me (see page 12), or WINDOWS 
 4.0 (see page 12), you must install that 

iver on the server before installing it on the 
ent.

stall the appropriate WINDOWS driver
ee page 13) or MACINTOSH driver 
ee page 14) on the client system.

Installing the P

The ML-500 por
source folder wh
The port monitor
system. 
1. Verify that a 

(see page 44
If a Source fo
Server applic
folder will be
path: (C:\ML

IMPORTANT: If 
ab

2. Insert the KO
Digital Photo

3. Select a lang

4. Click Port M
Properties sc

5. Click Add Po
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6. Cl

7. Cl

8. O
fo
ex

9. Se

10. Cl

k Source Directory Port from the 
 the New Port... button.

rt number (1-999) and the name of 
lder you wish to use. Click OK. 

 boxes until the Printers window 
 front.
t verify the Source folder in step 1, 
e able to complete this step.

propriate ML-500 printer drivers for 
 system you will be printing from. 
lect the EKSD local port for the 

 to use, and share the printer over 

wing instructions for specific 
etails.
tem Requirements and Installation

Back Indexnts Next

ick the Add Port button.

ick the New Port Type... button.

n the CD drive, browse to the Port Monitor 
lder in the appropriate language folder (for 
ample, <CD drive>:\English\Port Monitor).

lect the appropriate .INF file:

WINDOWS 2000: select the MONITOR.INF 
file.

WINDOWS XP: select the EKSDPM.INF file.
ick Open, then click OK.

11. Select Koda
list then click

12. Specify a po
the Source fo
Close dialog
comes to the
If you did no
you will not b

13. Install the ap
the operating
Be sure to se
printer driver
the network.
See the follo
installation d
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Insta

Install
Serve

1. In
Di

2. Se

3. Cl
W

4. Fo
Ch
di
✔

e Printer Port dialog box 
WS 2000), Select a Printer Port 
x (WINDOWS XP)

Use the following port and select 
Dn port where n is the number that 
d when the port monitor was 
. Click Next.
ter Wizard dialog box 

WS 2000), Install Printer 
e dialog box (WINDOWS XP)
og box displays a list of 
turers and their associated 

the Have Disk... button to display 
stall from Disk dialog box.
the Browse... button to display the 
e File dialog box.
 default, the Add Printer Wizard 
plays the last .INF file installed (the 
rt Monitor .INF file). DO NOT 
ose the Port Monitor .INF file; this 

 will not install the driver.
tem Requirements and Installation

Back Indexnts Next

lling WINDOWS Printer Drivers

ing the WINDOWS 2000/XP Driver on the 
r System

sert the KODAK PROFESSIONAL ML-500 
gital Photo Print System CD.

lect the appropriate language.

ick Printer Drivers to display the Add Printer 
izard screen.

llow the Add Printer Wizard instructions. 
oose the appropriate settings for the wizard 

alog boxes, as outlined here:
Local or Network Printer dialog box
a. Select Local Printer.
b. Uncheck Automatically detect and 

install my Plug and Play printer.
c. Click Next.

✔ Select th
(WINDO
dialog bo
Choose 
the EKS
was use
installed

✔ Add Prin
(WINDO
Softwar
This dial
manufac
printers.
a. Click 

the In
b. Click 

Locat
IMPORTANT: By

dis
Po
cho
file
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✔

✔

 and Comment dialog box
ly supply a location and comment 
splayed in the Printers list.
st Page dialog box
o.
ting the Add Printer Wizard 
x
ish.
ignature Not Found dialog box

s to continue the installation.

inter driver is not listed in the 
ow after the installation is 
lect Refresh from the View menu.

 use the logo feature in the driver, 
able advanced printing. 
 the ML-500 printer and select 
s).
dvanced tab.
nable advanced printing 
tem Requirements and Installation

Back Indexnts Next

c. Navigate to the directory on the CD 
where the ML500.inf file resides, for 
example, 
<CD_drive>:\English\Print_Driver\Win_X
P_Win_2000).

d. Open this file. The Install From Disk 
dialog box reappears.

e. Click OK.
The Kodak Professional ML-500 printer 
appears in the list.

f. Click Next.
Name your Printer dialog box
Click Next to accept the default selections 
or choose an appropriate printer name. 
Select whether or not you want this to be 
the default printer.
Printer Sharing dialog box
Choose Share as: so that the printer will be 
accessible from clients printing with drivers. 
Provide a share name to be displayed on 
the network.

✔ Location
Optional
that is di

✔ Print Te
Select N

✔ Comple
dialog bo
Click Fin

✔ Digital S
Click Ye

5. If the new pr
Printers wind
complete, se

6. If you plan to
you must dis
a. Right-click

Propertie
b. Click the A
c. Uncheck E

features.
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Install
Serve

1. Fr
se
an

2. Cl
Dr

3. Se
an

4. Yo
So
th

5. Br
W
M

6. Th
re

NDOWS NT Driver on the Server 

peration of the WINDOWS NT 4.0 
, you must first install the 
000 printer driver (see page 10) on 
rint Server.

g the WINDOWS 2000 printer 
 the WINDOWS NT 4.0 printer 
 same Print Server using the 
FESSIONAL ML-500 Digital Photo 
 CD. When asked to select a port, 
ame EKSDn port as selected for 
S 2000 printer driver. Be sure to 
re name that identifies this driver 
r WINDOWS NT 4.0 users.

stall this driver under the Additional 
indow of the WINDOWS 2000 
iver's Sharing tab. You would have 
l over the default printing 

ces.
tem Requirements and Installation

Back Indexnts Next

ing the WINDOWS 98/Me Driver on the 
r System

om the Start menu select Settings, then 
lect Printers. Right-click the ML-500 printer 
d select Properties.

ick the Sharing tab and click the Additional 
ivers button.

lect the INTEL WINDOWS 9x environment 
d version and click OK.

u will be prompted to place the ML-500 
ftware CD in your drive. Ensure the CD is in 

e drive and click OK.

owse to the English/Printer_Driver/ 
in 98 Win Me folder on the CD and select the 
L500.INF file. Click OK.

e driver will be installed and the Sharing tab 
appears. Click Close. 

Installing the WI
System

1. For proper o
printer driver
WINDOWS 2
the ML-500 P

2. After installin
driver, install
driver on the
KODAK PRO
Print System
choose the s
the WINDOW
specify a sha
specifically fo

NOTE: Do not in
Drivers w
printer dr
no contro
preferen
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Install
the Cl

From 
system
1. Ch

to

2. Fr

3. Ty
th
Pr

4. Ba
rig
an

NOTE

driver will be installed on the client 
 new printer driver is not listed in 
indow after the installation is 

lick the View menu and select 

rint Server Application is running 
r, and you are ready to print from 
tem. 
tem Requirements and Installation

Back Indexnts Next

ing the WINDOWS Drivers (any version) on 
ient System

the client system, browse to the print server 
 and install the shared printer on the client:
eck that your computer is properly connected 

 your network.

om the Start menu select Run.

pe \\"system name" where "system name" is 
e name of the system running the ML-500 
inter Utilities. Click OK.

sed on your client operating system, 
ht-click the appropriate ML-500 printer name 
d select Open.
: There will be one printer listed for 

WINDOWS 98, Me, 2000 and XP Operating 
Systems and one printer listed for 
WINDOWS NT 4.0 Operating System.

5. The ML-500 
system. If the
the Printers w
completed, c
Refresh.

6. Ensure the P
on the serve
the client sys
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Insta

Install
Syste

1. Do

2. En
pa

3. Re

4. Se
de

5. Cl

6. Re
NOTE

MACINTOSH Printer Driver

ML500 folder from the 
rs/Kodak folder on the volume 

 your MACINTOSH computer.
 need to change permissions for 
r or log in as root to remove this 

er, delete the printer from the 
tem Requirements and Installation

Back Indexnts Next

lling the MACINTOSH Printer Driver

ing the MACINTOSH Driver on the Client 
m

uble-click the ML-500.pkg file.

ter the Administrator name and authorization 
ssword.

spond to the ReadMe and License prompts.

lect the startup disk volume for the 
stination.

ick Install or Update.

start your computer.
: It is not necessary to install the 

MACINTOSH printer driver on the server 
system.

Uninstalling the 

1. Remove the 
Library/Printe
used to start

NOTE: You may
the folde
folder.

2. In Print Cent
printer list.
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Befo
Ope

Before
Digita
follow

✔

✔

✔

inter

e Printer Utilities software, start the 
(see page 20). The following dialog 

nter name in the Name field (for 
L-500 Printer) and click OK.
tem Requirements and Installation

Back Indexnts Next

re You Can Print (WINDOWS 
rating Systems)

 using the KODAK PROFESSIONAL ML-500 
l Photo Print System, you must do the 
ing:
Name your printer in the ML-500 Utilities 
software.
Set preferences in the Print Server application 
(see page 16).
Ensure the appropriate XtraLife option is set 
in the Configuration application (see page 16).

Naming the Pr

After installing th
ML-500 Utilities 
box appears:

✔ Enter a pri
example, M
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Settin

1. St

2. Fr
Pr

3. Ch
(s
Th
fo
de
is 

4. Se
Th
pe
re
file
is 

5. Ch
(s

TRALIFE Option

figuration application 
).

neral tab (see page 27).

e XTRALIFE ribbon type is set to 
bbon you are using on the printer 
atte). See page 30.

ompleted these preparations, TIFF 
ced in the source folder will be 
tem Requirements and Installation

Back Indexnts Next

g Print Server Preferences

art the Print Server application (see page 41).

om the Server menu select Server 
eferences.

ange the Source folder, if needed 
ee page 44).
e Print Server application monitors this folder 

r files and places them in the print queue. A 
fault source folder (c:\ML-500 Source Folder) 
used if you don’t change source folders.

lect a log file, if needed (see page 44).
e log file is a text (*.txt) file where all actions 
rformed by the ML-500 Print Server are 
corded. A default log file (c:\program 
s\Kodak\ML-500\Utilities\<printer name>.txt) 
used if you don’t select a different one.

ange print job settings, if needed 
ee page 48).

Selecting the X

1. Start the Con
(see page 25

2. Click the Ge

3. Verify that th
the type of ri
(Glossy or M

Once you have c
or JPEG files pla
printed.
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Befo
Ope

After y
driver
follow
1. O

Se
(s

2. O
W
(s

3. O
pr
(s

INDOWS 2000 Server or 
NDOWS 2000 Advanced Server is 
uired for sharing the Source Folder 
ng File Services for MACINTOSH 
h the APPLETALK Protocol.

ompleted these steps, print jobs 
500 printer from any application, 
 WINDOWS Source folder. The 
e settings determine when the job 
tem Requirements and Installation

Back Indexnts Next

re You Can Print (MACINTOSH 
rating System)

ou have installed the MACINTOSH printer 
 on the client system, you must do the 
ing before printing:
n the WINDOWS server: Enable File 
rvices for MACINTOSH Operating System

ee page 18).

n the WINDOWS server: Share the 
INDOWS Source folder 
ee page 18).

n the MACINTOSH client: Add the ML-500 
inter to the Printer List 
ee page 19).

IMPORTANT: W
WI
req
usi
wit

Once you have c
going to the ML-
are placed in the
print server queu
is printed.
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Enab
Oper

On th
Serve
1. Ri

Pr

2. Se
O
th
Co

3. Ch
Se

4. Se

5. Cl
Al

NOTE

rver’s Source Folder

r resides on the WINDOWS 
obs are queued there for printing. 
 be shared for you to access it. 
 folder is shared, you can set up 
 driver so that print jobs are sent to 

r.
tem Requirements and Installation

Back Indexnts Next

ling File Services for MACINTOSH 
ating System

e WINDOWS 2000 Server or Advanced 
r System:
ght-click My Network Places and choose 
operties.

lect Advanced in the Menu bar and choose 
ptional Networking Components to display 
e WINDOWS Optional Networking 
mponents wizard.

eck the Other Network File and Print 
rvices check box and click Details.

lect File Services for Macintosh.

ick OK.
l necessary files are copied to your system.
: You may be prompted to insert the 

WINDOWS Server CD.

Sharing the Se

The Source folde
server. ML-500 j
This folder must
Once the Source
the MACINTOSH
the Source folde
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On th
Serve
1. Ri

2. Ex
an

3. Ri
Sh

4. Br
up

5. Ty

6. Be
ch

-500 Printer to the Printer List

OSH client:
int Center.

hoose Kodak File from the 
tocol list, then click Select.

he WINDOWS Source folder and 
.

r with the same name as the 
r should appear in the printer list.
tem Requirements and Installation

Back Indexnts Next

e WINDOWS 2000 Server or Advanced 
r System:
ght-click My Computer and choose Manage.

pand the Shared Folders in the left panel 
d select Shares.

ght-click and select New, then select File 
are.

owse to the Source folder that has been set 
 on the WINDOWS server.

pe a share name, for example, ML500.

 sure Macintosh Share (not Windows) is 
ecked.

Adding the ML

On the MACINT
1. Open the Pr

2. Click Add, c
Printing Pro

3. Navigate to t
click Choose

4. Click Add.
A new printe
Source folde
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ML-500 P

This s
Print U
with th
Photo

ML-5

The M
launch

Co
pri
sta

Pr
im

Ca
co
the

L-500 Utilities

tart menu select Programs, then 
ak Professional ML-500 Utilities. 

 shortcut to your desktop, right-click 
rofessional ML-500 Utilities in 
 menu. Choose Send to, then 
esktop (create shortcut).
500 Print Utilities

Back Indexnts Next

rint Utilities

ection provides an overview of the ML-500 
tilities and the ML-500 applications that work 
e KODAK PROFESSIONAL ML-500 Digital 
 Print System.

00 Utilities

L-500 Print Utilities acts as a program 
er for the following ML-500 applications:

nfiguration (see page 25): Lets you change 
nter settings and monitor printer and media 
tus

int Server (see page 41): Lets you print 
ages on the ML-500 printer

libration (see page 75): Lets you control the 
lor balance and density of images printed on 
 ML-500 printer

Starting the M

✔ From the S
select Kod

NOTE: To add a
Kodak P
the Start
choose D



ML-

Conte 21

Utility

The U
Utilitie
ML-50
the ap
open,
viewin

You c
scree

ity Bar using the grab handles:
cursor over the grab handles. 

g the Utility Bar to a new location. 
 Utility Bar to the right or left of the 
ow attaches it to that edge.

ity Bar using the floating window 

ting window button. 
r detaches from the edge of the 

r cursor over the title bar.

g the Utility Bar to a new location. 
 Utility Bar to the right or left of the 
ow attaches it to that edge.

y Bar On or Off

ile menu select Utility Bar.
500 Print Utilities

Back Indexnts Next

 Bar

tility Bar is located at the left of the ML-500 
s screen. It contains icons that represent the 
0 applications. Double-clicking an icon opens 
plication. If two or more applications are 

 you can bring an application to the front of the 
g window by clicking its icon in the Utility Bar.

an move the Utility Bar anywhere on the 
n.

To move the Util
1. Position the 

2. Click and dra
Dragging the
viewing wind

To move the Util
button:
1. Click the floa

The Utility Ba
screen.

2. Position you

3. Click and dra
Dragging the
viewing wind

Turning the Utilit

✔ From the F
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Start

✔

L-500 Applications

 at the upper right of the screen, 
e, the Configuration screen.
you select Exit from the File menu, 
ML-500 applications close.

ss the Ctrl and F4 keys or click the 
ile menu.
500 Print Utilities

Back Indexnts Next

ing ML-500 Applications

From the File menu select Open 
Configuration, Open Print Server, or Open 
Calibration.
Alternatively, double-click the appropriate icon 
on the Utility Bar.

Closing the M

✔ Click the
for exampl

IMPORTANT: If 
all 

Alternatively, pre
icon next to the F
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Selec

If mor
comp
to use
1. Le

ot
If 
di
ea

2. Fr

 Viewing Open Applications

re applications are running, you 
r windows to suit your preference:
indow menu select:

Application windows appear 
on one another
ation windows share window space 

ons: organizes minimized 
 icons
tion (if already open): makes 
nfiguration current
er (if already open): makes ML-500 
r current

n (if already open): makes ML-500 
 current
de view, the top window reflects 
nt application. In Tile view, the 
ed window is current. To make 
window current, simply click it, or 
rom the Window menu.
500 Print Utilities

Back Indexnts Next

ting a Printer

e than one printer is installed on your 
uter, you can choose the printer that you wish 
:
aving the ML-500 Utilities open, close all 

her running ML-500 applications.
you proceed without closing applications, 
alog boxes may appear to confirm closing of 
ch application.

om the Printer menu, select a printer.

Arranging and

When two or mo
can arrange thei

✔ From the W
Cascade: 
stacked up
Tile: applic
equally
Arrange Ic
application
Configura
ML-500 Co
Print Serv
Print Serve
Calibratio
Calibration

NOTE: In Casca
the curre
highlight
another 
select it f
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Exitin

IMPO

1. Ex

2. Fr
Al
th
F4
500 Print Utilities

Back Indexnts Next

g the ML-500 Utilities

RTANT: You can exit the ML-500 Utilities at 
any time; however, if any ML-500 
applications are running, you will be 
prompted to close them. If you 
continue exiting the ML-500 Utilities, 
open applications will be interrupted 
and closed, and unsaved information 
may be lost. Whenever possible, 
make sure to close running 
applications before exiting the ML-500 
Utilities.

it all running applications.

om the File menu select Exit.
ternatively, click the  at the upper-right of 
e ML-500 Utilities window, or press Alt and 
.
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ConfiguraOve

Using
chang
speed

✔

✔

✔

✔

✔

✔

rted

onfiguration Application

onfiguration icon on the Utility bar.

uration screen appears.
figuration

Back Indexnts Next

tionrview

 the ML-500 Configuration application you can 
e printer settings such as power saver, print 
, and image length. You can also:
Monitor the printer and media status
Obtain serial numbers and firmware versions
View the error history
Make a test print
Adjust color alignment and cutter
Download new firmware

Getting Sta

Starting the C

✔ Click the C

The Config
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Statu

The S
shows

One o
Initiali
Setup

One o
✔

✔

✔

✔

g the Status Bar

iew menu select Status Bar.

 Configuration Screen

reen with current printer 

iew menu select Refresh or press 
.

nfiguration Application

at the upper right of the 
ion screen.
you select Exit from the File menu, 
ML-500 applications close.
figuration

Back Indexnts Next

s Bar

tatus Bar, located at the bottom of the window, 
 the current state of the printer and media.

f the following printer states appears: Ready, 
zing, Printing, Printing stopped, Canceling, 
, Cooling, or Not found.

f the following media states appears:
OK (all ribbon and paper supplies exceed the 
low state)
Low (any ribbon or paper supply is at or 
below the low state)
Empty (any ribbon is missing or empty, or 
paper supply is empty)
Unknown (the state of any ribbon or paper 
supply is unknown)

Showing or Hidin

✔ From the V

Refreshing the

To update the sc
information:

✔ From the V
the F5 key

Closing the Co

✔ Click the 
Configurat

IMPORTANT: If 
all 
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Setu

Gene

Most 
Gene

nguage for the Printer Control 

ol panel on the front of the ML-500 
status and error information. When 
e ML-500 printer, you should 
ge to appear in the Printer control 

neral tab.

sh, French, German, Italian, 
Portuguese.
figuration

Back Indexnts Next

p

ral Tab

setup functions are accessed through the 
ral tab.

Selecting a La
Panel

The Printer contr
printer provides 
you first set up th
select the langua
panel.
1. Click the Ge

2. Select Engli
Spanish, or 

3. Click Apply.
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Settin

Set th
ML-50

The p
printe
1. Cl

2. To
Cl
ar
Re

e date:
w next to the month to display a 

ndar.

ws at the top of the calendar to 
rrect month and year.
e.
figuration

Back Indexnts Next

g the Time and Date

e time and date when first setting up the 
0, then as needed. 

rinter time and date are associated with 
d images. 
ick the General tab (see page 27).

 change the time:
ick a field, for example, hours, then use the 
rows to select the appropriate number. 
peat for each field.

3. To change th
Click the arro
monthly cale

Use the arro
select the co
Click the dat

4. Click Apply.
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Settin

To con
save s
can sp
remai
effect
1. Cl

2. Se
al

3. Se

4. Cl
NOTE

dia Low Threshold

the media low threshold. When the 
eaches this threshold, a media low 
 the Status Bar and in the Media 

he General tab.
neral tab (see page 27).

ber between 10 and 500 ft (3.018 
).
figuration

Back Indexnts Next

g the Power Saver

serve energy, the ML-500 goes into a power 
tate after a specified period of inactivity. You 
ecify the amount of time that the printer 

ns inactive before the power saver takes 
.
ick the General tab (see page 27).

lect the Power saver check box if it is not 
ready selected.

lect the number of minutes of inactivity.

ick Apply.
: Pressing any printer button "awakens" the 

printer from the power saver.

Setting the Me

You can specify 
ribbon or paper r
status appears in
Supply area on t
1. Click the Ge

2. Enter a num
and 152.4 m

3. Click Apply.
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Selec

You c
is usu
1. Cl

2. Se

3. If 
le
Th
m

4. Cl

aper Type

the type of paper used in your 
 there is only one paper type, but 
ers in the future.

neral tab (see page 27).

er type.
figuration

Back Indexnts Next

ting the XTRALIFE Ribbon Type

an select glossy or matte ribbon type. (Matte 
ally used for portrait work.)
ick the General tab (see page 27).

lect a ribbon type.

you selected Matte, you can specify a Matte 
vel or use the default.
e range is -4 to 4, with 4 providing the highest 

atte level and -4 the lowest.

ick Apply.

Selecting the P

You can specify 
printer. Currently
there may be oth
1. Click the Ge

2. Select a pap

3. Click Apply.
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Choo

1. Cl

2. Ch
No
Cu
be
Tr
wi
le
figuration

Back Indexnts Next

sing Default Settings for the Cutter

ick the General tab (see page 27).

oose an option:
 cuts - the paper will not be cut
t between prints - the paper will be cut once 
tween images
im leading and trailing edges - the paper 
ll be cut twice between images to remove 
ading and trailing edges

3. Click Apply.



Con

Conte 32

Adjus
Regis

1. Cl

izard.

n the Registration Wizard screen.
 test print is sent to the printer.

 test print and note the number 
 following occurrences:
: magenta and yellow converge
agenta and cyan converge
e point at which the cutter 

s the diagonal line
ll values are zero.
figuration

Back Indexnts Next

ting Print Head and Paper Cutter 
tration

ick the Settings tab.

2. Click Start W

3. Click Next o
A registration

4. Examine the
closest to the
✔ Magenta
✔ Cyan: m
✔ Cutter: th

intersect
NOTE: Ideally a
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genta, Cyan, and Cutter values 
stration test print and click Next.
 for Magenta and Cyan are -64 to 

 for the cutter are -16 to +16

 print another test print or click 
se the wizard.
figuration

Back Indexnts Next

5. Enter the Ma
from the regi
Valid entries
+64.
Valid entries

6. Click Next to
Finish to clo
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View

1. Fr

2. Un
yo

3. Cl

Dow

You m
firmwa
firmwa
IMPO

e firmware file from the Kodak Web 
w.kodak.com/global/en/service/

500/ml500Software.jhtml) to your 
rd drive.

wnload Firmware tab.

e.
figuration

Back Indexnts Next

ing and Changing Printer Names

om the Printer menu select Edit List.

der Name, highlight the name of the printer 
u wish to change and type a new name.

ick OK.

nloading Firmware

ay occasionally need to download new 
re for your printer. One file contains all 
re, regardless of what is new.

RTANT: Do not turn off the printer or remove 
any cables during the download 
process. If you do, the download will 
not complete and the previous 
firmware version will be used.

1. Download th
site (http://ww
software/ML
computer ha

2. Click the Do

3. Click Brows

http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml
http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml
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4. In
fo
(.r

5. Se

6. Cl
A 
tim
pr

7. If 
in
"R
th
If 
in
ar
pr

tatus

ter Identification

entification tab to view the 

bers for the printer and print heads
ersions for printer components
figuration

Back Indexnts Next

 the File Open dialog box, navigate to the 
lder containing the downloaded firmware 
om) file.

lect the firmware file.

ick Download.
message indicates the approximate download 
e and an elapsed time indicator shows the 

ogress of the download.

the download was successful, you will be 
structed to power the printer off / on. Wait for 
eady" to appear in the printer's control panel, 
en click OK.
the download was not successful you will be 
structed try again, then, if repeated attempts 
e unsuccessful, to obtain service for your 
inter.

Checking S

Checking Prin

✔ Click the Id
following:
Serial num
Firmware v
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Chec

There
status

✔

✔

✔

y

 history for your printer:
tory tab.

rrors or Service errors to view 
es of errors, paper usage, and 

of errors.
figuration

Back Indexnts Next

king Printer and Media Status

 are several ways to check printer and media 
:
The Status Bar (see page 26) indicates the 
current state of the printer and media
The General tab (see page 27) shows the 
amount of available media
The Usage tab (see page 37) shows 
information about printer and media usage

Viewing Histor

To view the error
1. Click the His

2. Click User e
dates and tim
descriptions 
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Chec

To vie
usage
the nu

✔

Media Supply

ion about each type of media on 
r:
eneral tab (see page 27) to view 
g:

maining for each type of media 
 cyan, magenta, yellow, and 
bon)
ch type of media (OK, Low, Empty, 

ears red in the Low and Empty 
figuration

Back Indexnts Next

king Printer Usage

w information about the current printer’s 
, the amount of paper used on the printer, and 
mber of paper cuts:
Click the Usage tab.

Checking the 

To view informat
the current printe

✔ Click the G
the followin
Amount re
(paper, and
XtraLife rib
State of ea
Unknown)

NOTE: Text app
states.
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Savin

You c
numb
saved
applic
1. Fr

Re

2. In
bo
Th
Re
wi

3. Cl

 Print

test print and look for artifacts such 
es, or banding. Some patterns 

 artifacts better than others.
t Print tab.

mber of copies to be printed 

ern (see the table on the next few 
Click Print.
figuration

Back Indexnts Next

g a Report

an save a report showing history, serial 
ers, and firmware versions. The report is 
 in a text file (.txt), which can be opened by an 
ation such as NotePad.
om the Configuration menu select Save 
port.

 the Save Printer Configuration Report dialog 
x, select a folder in which to save the report.
e file is named Printer Configuration 
port.txt. You can change the name if you 

sh.

ick Save.

Making a Test

You can make a 
as dust spots, lin
bring out certain
1. Click the Tes

2. Select the nu
(1 - 600).

3. Select a patt
pages) then 
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#1 Mi

#2 Mi

#3 Bo

#4 Gr

Output
figuration

Back Indexnts Next

Pattern Output

d gray

n gray

xes on mid gray

id on gray

#5 One pixel grid

#6 Two pixel grid

#7 Max gray

#8 Offset dots

Pattern
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#9 Re

#10 M

#11 M
figuration

Back Indexnts Next

gistration squares

atte XtraLife

ax CMYX- gray

Pattern Output
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Print SerOve

Using
Photo
basic 
(*.tif), 
NOTE

In add
print p

rted

int Server Application

rint Server icon on the Utility bar.
t Server

Back Indexnts Next

verrview

 the KODAK PROFESSIONAL ML-500 Digital 
 Print Server application, you can manage 
and custom printing of JPEG (*.jpg), TIFF 
and Rosetta (*.ros) image files.
: Rosetta files are created by the Print driver.

ition to printing individual image files, you can 
ackages or layouts (see page 59).

Getting Sta

Starting the Pr

✔ Click the P
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Statu

The S
provid

le describes the Status Bar fields.

g the Status Bar

iew menu select Status Bar.

Description

total number of print jobs in the print 
e

total number of copies for all print jobs 
e print queue

current state of the ML-500 Print 
er (Running, Suspended, or Force 

ting)

current state of the printer status 
dy, Initializing, Printing, Printing
ped, Canceling, Setup, Cooling, Not 
d)

current state of the ribbon and paper 
ia (OK, Low, Empty, Unknown)
t Server

Back Indexnts Next

s Bar

tatus Bar, located at the bottom of the window, 
es helpful information about printing status.

The following tab

Showing or Hidin

✔ From the V

Indicator

Jobs The 
queu

Copies The 
in th

Server The 
Serv
Prin

Printer The 
(Rea
Stop
Foun

Media The 
med
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Tool 

A Too
scree
acces

Using

✔

g the Tool Bar

iew menu select Tool Bar.

int Server Application

at the upper right of the Print 
en.

you select Exit from the File menu, 
ML-500 applications close.

M
Enq
t Server

Back Indexnts Next

Bar

l Bar appears at the top of the Print Server 
n. It provides shortcuts to functions that you 
s through the menus.

 the Tool Bar

Click a Tool Bar button to access the 
associated function.

Showing or Hidin

✔ From the V

Closing the Pr

✔ Click the 
Server scre

IMPORTANT: If 
all 

Force Print Now
Resume

Suspend
Flush

Dequeue
Move Down
ove Up
ueue
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Chan

The S
files. W
folder
queue

A defa
has b

If you
1. Fr

Pr

2. Ne

3. Se
cli

NOTE

g File

ext (*.txt) file where all actions 
 ML-500 Print Server are recorded. 
 the date and time the ML-500 Print 
 and stopped, as well as the date 
ing activities.

 (c:\program files\Kodak\ML-500\
name>.txt) has been created. 

ange the default, do the following:
rver menu select Server 
.

ile, click Browse.

ate a folder and log file name, then 
t Server

Back Indexnts Next

ging the Source Folder

ource folder is designated for printing image 
hen an image file is placed in the Source 

, a print job is created and placed in the print 
.

ult Source folder (c:\ML-500 Source Folder) 
een created.

 wish to change the default, do the following:
om the Server menu select Server 
eferences.

xt to Source Folder, click Browse.

lect a folder to use as the Source folder, then 
ck OK.
: If the print queue is suspended, print jobs 

are not created until printing resumes.

Selecting a Lo

The log file is a t
performed by the
The file contains
Server is started
and time of print

A default log file
Utilities\<printer 

If you wish to ch
1. From the Se

Preferences

2. Next to Log f

3. Select or cre
click Open.

4. Click OK.
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Prin

Maki

You m
be pri
are se
comp

Image
the Fa
print q
the So
image

If you
succe
Succe
The d
Jobs f
you a
Succe
that is

s to the Print Queue

queue appear on the Print Server 
t Server

Back Indexnts Next

ting and the Print Queue

ng Prints

ust create a print job before an image file can 
nted. Print jobs that appear in the print queue 
nt to the printer. Once a print job has 

leted, it disappears from the print queue. 

 files that don't print are temporarily stored in 
iled Jobs folder instead of being sent to the 
ueue. The Failed Jobs folder is located within 
urce folder. Check this folder occasionally for 
 files that failed to print.

 allocate disk space (see page 68), 
ssfully printed image files are sent to a 
ssful Jobs folder after leaving the print queue. 
efault disk space allotted for the Successful 
older is 0, so images are not sent there unless 
llocate space. Like the Failed Jobs folder, the 
ssful Jobs folder is a temporary storage area 
 located within the Source folder.

Adding Print Job

Jobs in the print 
screen.
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To cre
differ
NOTE

✔

To cre
same
NOTE

✔

✔

ify otherwise, printing starts when 
 the print queue. You can change 

imits (see page 68), or you can 
 forcing printing (see page 65).

se the number of jobs before 
 changing the print queue limits, 
d.
 does not start, check that printing 

spended (see page 64).
t Server

Back Indexnts Next

ate a print job when images are on a 
ent computer than the ML-500 Print Server:
: Images are deleted from the Source folder 

after a job has run.
Copy an image file into the Source folder 
(see page 44).

ate a print job when images are on the 
 computer as the ML-500 Print Server:
: Images are not deleted after a job has run.

Drag and drop individual image files or groups 
of image files into the print queue on the Print 
Server screen. Change settings, if needed, 
then click OK.
Manually create a print job using the Enqueue 
command (see page 47).

Unless you spec
one print job is in
the print queue l
override them by

When you increa
printing starts by
less paper is use
NOTE: If printing

is not su
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Manu

1. Fr
pr

e File, click Browse to locate the 
 files, then click Open.

r settings, if needed, then click OK.

nting, select Resume from the 
.

t Server
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ally Creating a Print Job

om the Server menu select Enqueue or 
ess the Enqueue Tool Bar button.

2. Next to Imag
image file or

3. Change othe

4. To initiate pri
Server menu
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Print 

Print s
featur
specif
using 

 next few pages for descriptions 
s for the settings.
t Server

Back Indexnts Next

Job Settings

ettings are used to change a variety of 
es, from altering a print's appearance to 
ying print queue options. Change settings 
the Job Preferences dialog boxes. 

See the table on
and default value
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Print le Range See

Copie Selecting the number 
of copies to print 
(see page 54)

Cutte
een prints

ding and 
dges

Choosing paper 
cutting boundaries 
(see page 55)

Sharp Sharpening images 
(see page 56) 

Use l Labeling prints 
(see page 56) 

Leadi
(pixel

Adjusting borders on 
prints (see page 57) 
t Server

Back Indexnts Next

Setting Description Default Value Allowab

s Specifies the number of 
copies to print

1 1 - 9999

r Specifies how to cut the 
paper

Cut between prints No cuts
Cut betw
Trim lea
trailing e

en Specifies the level of 
image sharpness

Normal None
Normal
High

abel Specifies whether to 
use a label and allows 
selection of label text

(Unchecked) 
Define: 
Date and time stamp 
(checked)
Black (selected)

ng border 
s) *

Specifies the amount of 
white space that prints 
before the image

75 0 - 3000
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Trailin
(pixel

Adjusting borders on 
prints (see page 57) 

Image
(pixel

Adjusting borders on 
prints (see page 57)

Cente Adjusting borders on 
prints (see page 57)

Color Using color 
management 
(see page 58)

Input h the 
n ICC or ICM

Using color 
management 
(see page 58)

Use e
profile

Using color 
management 
(see page 58)

Print le Range See
t Server

Back Indexnts Next

g border 
s) *

Specifies the amount of 
white space that prints 
after the image

75 0 - 3000

 offset 
s) *

Specifies the amount of 
white space that prints 
on the left side of the 
image

Not applicable if 
Center Image box is 
checked, otherwise 
75

0 - 2560

r image Ensures that an equal 
amount of white space 
prints on both sides of 
the image

(Checked)

 management Enables the use of 
color management for 
the print

Off

profile Specifies the input 
profile to use for 
printing

sRGB Color Space 
Profile

Files wit
extensio

mbedded 
s

Specifies use of 
embedded profiles for 
images if any are 
available

(Checked)

Setting Description Default Value Allowab
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* 300 

Outpu h the 
n ICC or ICM

Using color 
management 
(see page 58)

Rend ual (for 

on (for 
)

etric (for 
match)

Using color 
management 
(see page 58)

Packa Selecting a print 
package or layout 
(see page 59)

Layou Selecting a print 
package or layout 
(see page 59)

Scalin  fit
 fit

Selecting a print 
package or layout 
(see page 59)

Print le Range See
t Server

Back Indexnts Next

pixels = one inch

t profile Specifies the output 
profile to use for 
printing

ML-500 3Color Photo 
Gloss

Files wit
extensio

ering intent Specifies the type of 
output for the print job

Perceptual (for 
photos)

Percept
photos)
Saturati
graphics
Colorim
closest 

ge Specifies the layout of 
the package being 
printed

None

t Specifies the layout of 
the image being printed

None

g Specifies the preferred 
scaling type 

Scale to fit Scale to
Scale to

Setting Description Default Value Allowab
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Displa
Settin

You c
✔

✔

✔

A diffe
dialog

ngs for all jobs in the Source 

erver menu select Job 
es.
eferences dialog box appears.
t Server

Back Indexnts Next

ying a Dialog Box for Changing Print Job 
gs

an change job settings for the following:
Jobs in the Source folder
When manually enqueuing files
For jobs already in the queue

rent dialog box is used for each method. All 
 boxes contain the same tabs.

To change setti
Folder:

✔ From the S
Preferenc
The Job Pr
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To ch
jobs:
1. Fr

Th

ngs for jobs already in the 

erver window, click the job or jobs 
 wish to change print settings. 
old the Ctrl key while clicking to 
le jobs. Press and hold the Shift 
king to select a range of jobs.)

e highlighted job (or any one of the 
bs if more than one is highlighted).
ot change print settings for jobs 
n Printing or Sending status.
t Server

Back Indexnts Next

ange settings when manually enqueuing 

om the Server menu select Enqueue.
e Enqueue Print Job dialog box appears.

To change setti
queue:
1. In the Print S

for which you
(Press and h
select multip
key while clic

2. Right-click th
highlighted jo

NOTE: You cann
that are i
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Th mber of Copies to Print

 the number of copies for a print 

log box for changing print job 
 page 52).

b Settings tab.

es, select the number of copies, 
efault) and 9999, to print.

tta (*.ros) image files, this setting is 
d by the ML-500 Printer Driver and 
e changed using the ML-500 Print 
t Server
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e Edit Print Job dialog box appears. Selecting the Nu

You can change
job.
1. Display a dia

settings (see

2. Select the Jo

3. Next to Copi
between 1 (d

4. Click OK.
NOTE: For Rose

controlle
cannot b
Server.
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Choos

W
T
in
p

You c
choos
1. Di

se

2. Se

3. Un
No
Cu
cu
Tr
wi
le
t Server
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ing Paper Cutting Boundaries

ARNING:
he cutter is very sharp and can cause 
jury. Stay away from the cutter when the 
rinter is running.

an choose how prints are cut, or you can 
e not to cut prints at all:
splay a dialog box for changing print job 
ttings (see page 52).

lect the Job Settings tab.

der Cutter, select an option.
 Cuts - the paper will not be cut
t between prints (default) - the paper will be 

t once between images
im leading and trailing edges - the paper 
ll be cut twice between images to remove 
ading and trailing edges

4. Click OK.



Prin

Conte 56

Sharp

1. Di
se

2. Se

3. Un
No
sh
ch
No
sh
ha
Hi
wi
sh

4. Cl
NOTE

els (up to 256 characters) to your 
ntify them.

u create appears below the image 
h to the trailing border.
log box for changing print job 
 page 52).

b Settings tab.

, select Use Label.

.

he options under Information and 
u can enter additional text in the 

box.

lose the Define Label dialog box.

e Label option is checked and the 
ettings are not changed, the date 
 are printed in black.
t Server

Back Indexnts Next

ening Images

splay a dialog box for changing print job 
ttings (see page 52).

lect the Job Settings tab.

der Sharpen, select an option:
ne - No sharpening is applied. Use when 
arpening is applied elsewhere in the imaging 
ain.
rmal (default) - Moderate amount of 
arpening is applied. Use with images that 
ve good sharpness.
gh - Increased sharpening is applied. Use 
th images that have less than optimal 
arpness.

ick OK.
: For Rosetta (*.ros) image files, this setting is 

controlled by the ML-500 Printer Driver and 
cannot be changed using the ML-500 Print 
Server.

Labeling Prints

You can add lab
prints to help ide

The text label yo
and adds 1/2 inc
1. Display a dia

settings (see

2. Select the Jo

3. Under Label

4. Click Define

5. Select from t
Text color. Yo
Custom text 

6. Click OK to c

7. Click OK.
NOTE: If the Us

default s
and time
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Adjus

You c
chang
the im

The d
is 75 p
This e
white 
and e
NOTE

1. Di
se

2. Se

3. Ch
✔

railing Border, select the amount of 
ace, between 0 and 3000, that will 
r the image.
e the amount of white space that 

 on either side of the image, 
 the Center Image box. Next to 
ffset, select the amount of white 
etween 0 and 2560, from the left 
the paper to the left edge of the 
he amount on the right side of the 
ill decrease by this amount.
h paper, you may need to adjust 
head and paper cutter registration 
e 32) to center the image.

tta (*.ros) image files, this setting is 
d by the ML-500 Printer Driver and 
e changed using the ML-500 Print 
t Server

Back Indexnts Next

ting Borders on Prints

an reposition an image on a print, which 
es the thickness of the white borders around 
age.

efault spacing for leading and trailing borders 
ixels, and the Center Image box is checked. 
nsures that there will be equal amounts of 
space on the top and bottom of the image, 
qual space on the left and right of the image.
: 300 pixels = 1 in. = 2.54 cm (for example, 

900 pixels = 3 in. = 7.62 cm)
splay a dialog box for changing print job 
ttings (see page 52).

lect the Job Settings tab.

ange the settings under Image Placement:
Next to Leading Border, select the amount 
of white space, between 0 and 3000, that 
will print before the image.

✔ Next to T
white sp
print afte

✔ To chang
will print
deselect
Image O
space, b
edge of 
image. T
image w

NOTE: For 8 inc
the print 
(see pag

4. Click OK.
NOTE: For Rose

controlle
cannot b
Server.
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Using

The P
mana
reprod
Furthe
mana
print-t

For co
must 
profile
corres
determ
desire

The U
allows
profile

sRGB
profile
defau
Gloss

log box for changing print job 
 page 52).

olor Management tab.

n option for Color Management.
t Server
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 Color Management

rint Server contains embedded color 
gement support. This allows optimum color 
uction to be achieved from your image files. 
rmore, if your monitor is properly color 

ged, it will improve the degree of 
o-monitor match that is obtained.

lor management to function correctly, you 
specify an input and output profile. The input 
 determines the color values for the 
ponding image data. The output profile 
ines the correct printer values to produce the 

d color values.

se embedded profile if available option 
 automatic selection of the correct input 
 if one is embedded in the image file.

 is automatically selected as the default input 
 since many imaging devices use this as their 
lt. You should select the ML-500 Matte or 
y profile as your output profile.

1. Display a dia
settings (see

2. Select the C

3. Select the O
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4. Ne

5. Se

6. Ne

7. Se

8. Se

9. Cl

 Package or Layout

inting, you send a single document 
er and get multiple document page 
nt. For example, if you select the 
. and 3.5 x 5 in. and Wallets," your 
e 5 x 7 in. print, one 3.5 x 5 in. 
ber of wallet size prints (depending 
ize selected).

 be sure the image in the document 
 is the same size as the largest 
in the package. For example, if you 
ge "5 x 7 in. and 3.5. x 5 in. and 
ge on your original document page 
n. If necessary, resize the image on 
ge in an application such as 
SHOP before printing.

ing, you send a single document 
er and get multiple copies of the 
ur print. For example, if you select 
 6 in (Borderless)," your print 
derless 4 x 6 prints.
t Server
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xt to Input Profile, click Browse.

lect an input profile and click Open.

xt to Output Profile, click Browse.

lect an output profile and click Open.

lect a Rendering Intent.

ick OK.

Selecting a Print

With package pr
page to the print
sizes on your pri
package "5 x 7 in
print contains on
print, and a num
upon the paper s

For best results,
you wish to print
document page 
select the packa
Wallets," the ima
should be 5 x 7 i
the document pa
ADOBE PHOTO

With layout print
page to the print
same size on yo
the package "4 x
contains two bor
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The p
aspec
1. Di

se

2. Se

ckage or Layout option.

 to Fit or Scale to Fill.

e, the aspect ratio of the image file 
.
results when using "borderless" 
s, use the Scale to Fill option.

tta (*.ros) image files, this setting is 
d by the ML-500 Printer Driver and 
e changed using the ML-500 Print 

ngest edge of the image file is scaled 
ch the desired layout size. In some 
, the shorter edge of the image file will 
rter than the layout size when printed.

rinted image will be the exact size of 
out selected. In this case, the image 

scaled so that the shortest edge 
es the layout size. In some cases, the 
 edge will extend beyond the layout 
nd will not be printed.
t Server
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rint sizes may not be exact because of the 
t ratio of the images on the document page. 
splay a dialog box for changing print job 
ttings (see page 52).

lect the Packages and Layouts tab.

3. Select the Pa

4. Select Scale

In either cas
is maintained

NOTE: For best 
package

5. Click OK.
NOTE: For Rose

controlle
cannot b
Server.

Scale to 
Fit

The lo
to mat
cases
be sho

Scale to 
Fill

The p
the lay
file is 
match
longer
size a
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Using

To cre
see p
1. Di

se

2. Se

.

e.

ection box, locate the custom 
ayout file you wish to use, or 
st and most recently used custom 

at the bottom of the drop-down 

m package has never been 
then a custom package file will not 
 drop-down package list.
ave your selection. The preview 
ges to represent the actual custom 
ut.

y page size mismatch messages.
ion of a custom package fits on the 
rtial image is outlined in red, and a 
pears indicating that some images 
 package file are off the page.
t Server
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 Custom Printing Packages or Layouts

ate a custom printing package or layout, 
age 127.
splay a dialog box for changing print job 
ttings (see page 52).

lect the Packages and Layouts tab.

3. Click Custom

4. Click Brows

5. In the file sel
package or l
choose the la
package file 
package list.

NOTE: If a custo
created, 
be on the

6. Click OK to s
window chan
package layo

7. Check for an
If only a port
page, the pa
message ap
in the custom
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8. Se
th
en

9. Cl
NOTE

s from the Print Queue

ecific job:
erver window, click the job you 
ve.

rver menu select Dequeue.
 press the Delete key, or press the 
ol Bar button.

iple jobs:
erver window, press and hold the 

 click the jobs you wish to remove.

rver menu select Dequeue or 
lete key.
t Server
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lect Scale to Fit to shrink the images to fit in 
e available space or select Scale to Fill to 
large the images to fit in the available space.

ick OK.
: For Rosetta (*.ros) image files, this setting is 

controlled by the ML-500 Printer Driver and 
cannot be changed using the ML-500 Print 
Server.

Removing Job

To remove a sp
1. In the Print S

wish to remo

2. From the Se
Alternatively,
Dequeue To

To remove mult
1. In the Print S

Ctrl key and

2. From the Se
press the De
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To rem
1. In

an
wi

2. Fr
Al
De

To rem
1. Fr

th

2. Cl

e Print Job Order

 the order in which print jobs are 
ving jobs within the queue.

le job:
erver window, click the job to be 

e following:
 Server menu select Move Up or 
wn.
d hold the Ctrl key and press the 
wn arrow keys.
 drop the highlighted job to the 
osition in the print queue.

e Move Up or Move Down Tool 
ns.
t Server
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ove a range of jobs from the print queue:
 the Print Server window, hold the Shift key 
d click the first and last jobs in the range you 
sh to remove.

om the Server menu select Dequeue.
ternatively, press the Delete key, or press the 
queue Tool Bar button.

ove all print jobs:
om the Server menu select Flush or press 
e Flush Tool Bar button.

ick OK.

Rearranging th

You can change
processed by mo

To move a sing
1. In the Print S

moved.

2. Do one of th
✔ From the

Move Do
✔ Press an

up or do
✔ Drag and

desired p
✔ Press th

Bar butto

Move Down
Move Up
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To mo
1. In

Ct

2. Fr
M
qu
hi
pr

To mo
1. In

Sh
ra

2. Fr
M
qu
hi
pr

NOTE

rinting

ks" the print queue by preventing 
t Server from sending print jobs to 
 prevents image files in the Source 

t to the print queue. Suspend the 
n you want to change the paper or 
m calibration or diagnostic tests.

remains suspended until printing is 
d (see page 65).
 that are currently being printed or 

nt to the printer will be printed 
e queue is suspended.

ing:
erver menu select Suspend,, or 
uspend Tool Bar button.

spended" appears in the Status 
t Server

Back Indexnts Next

ve multiple jobs:
 the Print Server window, press and hold the 
rl key and click the jobs to be moved.

om the Server menu select Move Up or 
ove Down to move the jobs up or down in the 
eue. Alternatively, drag and drop the 

ghlighted jobs to the desired position in the 
int queue.

ve a range of jobs:
 the Print Server window, press and hold the 
ift key and click the first and last jobs in the 

nge you wish to move.

om the Server menu select Move Up or 
ove Down to move the jobs up or down in the 
eue. Alternatively, drag and drop the 

ghlighted jobs to the desired position in the 
int queue.
: You cannot rearrange jobs with Printing or 

Sending status.

Suspending P

Suspending "loc
the ML-500 Prin
the printer. It also
folder being sen
print queue whe
ribbon, or perfor

The print queue 
resumed or force
NOTE: Print jobs

being se
before th

To suspend print
✔ From the S

press the S

"Server: Su
Bar.
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Resu

Resum
ML-50
opera

To res
✔

g

ng starts when one job is in the 
 can change print queue limits 
 desired. Force printing lets you 

its and begin printing immediately. 
s in the print queue are processed 

ntinues until all the jobs in the print 
n sent to the printer.

:
erver menu select Force Print 
ss the Force Print Now Tool Bar 

rce Printing" appears in the Status 
t Server

Back Indexnts Next

ming Printing

ing "unlocks" the print queue and sets the 
0 Print Server to its normal mode of 
tion.

ume printing:
From the Server menu select Resume, or 
press the Resume Tool Bar button.

"Server: Running" appears in the Status Bar.

Forcing Printin

By default, printi
print queue. You
(see page 68), if
override these lim
Existing print job
without delay.

Force printing co
queue have bee

To force printing
✔ From the S

Now or pre
button.

"Server: Fo
Bar.
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Atten

You c
attend
occur
before
mode
printin
availa

If you
occur
ackno
you a
occur
case, 
requir

All err

To sw
mode

✔

erences

ettings using the Server 
og box.

e on the next page for descriptions 
d default values.
t Server
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ded and Unattended Printing

an operate the ML-500 Print Server in 
ed or unattended mode. If a printing error 

s, attended mode requires direct intervention 
 printing can continue, while unattended 

 does not. Unattended mode is useful when 
g overnight, or during times when no one is 
ble to respond to error messages.

 are running in attended mode and an error 
s, printing is suspended until you 
wledge the error message that appears. If 
re running in unattended mode and an error 
s, printing continues when possible. In either 
printing stops if intervention is absolutely 
ed (loading paper, changing the ribbon, etc.).

ors are recorded in the log file (see page 44).

itch between attended and unattended 
s:
From the Server menu select Attended.

Server Pref

Change server s
Preferences dial

Refer to the tabl
of the settings an
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Print wable Range See

Thres 00 Setting print queue 
limits (see page 68)

Thres
(minu

500 Setting print queue 
limits (see page 68)

Startu pend - 
ume

Selecting a startup 
state (see page 69)

Succe 0000 Allocating disk space 
to print job folders 
(see page 68)

Failed 0000 Allocating disk space 
to print job folders 
(see page 68)
t Server
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Setting Description Default Value Allo

hold (jobs) Specifies the minimum 
number of print jobs required 
in the print queue before 
printing begins

1 1 - 1

hold override 
tes) 

Specifies the number of 
minutes after which printing 
begins, regardless of the 
threshold value

60 1 - 1

p state Specifies the startup mode of 
the print queue for the ML-500 
Print Server

Suspend Sus
Res

ssful jobs (MB) Specifies the amount of 
memory to allocate to the 
storage of successfully 
printed image files

0
Alert when full 
(unchecked)

0 - 5

 jobs (MB) Specifies the amount of 
memory to allocate to the 
storage of image files that 
failed to print

250
Alert when full 
(unchecked)

0 - 5
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Settin

Unles
one jo
numb
time t
begin

You c
your n
1. Fr

Pr

2. Un
th
an
pr

3. Ne
m
pr
va

4. Cl

 Space to Print Job Folders

 print queue, image files for failed 
to a Failed Jobs folder. If you have 
ace to the Successful Jobs folder, 
ccessful jobs are moved there. 

Jobs folder and Failed Jobs folders 
 generated and are located within 
r.

e, check the Failed Jobs folder for 
ailed to print.

 the amount of disk space each 
cifying the amount of memory 
:

t Server

Back Indexnts Next

g Print Queue Limits

s you specify otherwise, printing starts when 
b is in the print queue. You can change the 
er of jobs or the number of minutes from the 
he first print job was created before printing 
s.

an change the print queue limits to better suit 
eeds:
om the Server menu select Server 
eferences.

der Print Queue, next to Threshold, select 
e minimum number of print jobs, between 1 
d 100, required in the print queue before 
inting begins.

xt to Threshold, select the number of 
inutes, between 1 and 1500, after which 
inting will begin regardless of the Threshold 
lue.

ick OK.

Allocating Disk

After leaving the
jobs are moved 
allocated disk sp
image files for su
The Successful 
are automatically
the Source Folde

From time to tim
image files that f

You can allocate
folder has by spe
available to each
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1. Fr
Pr

2. Un
m
m
su
no
w

3. Sp
50
al
to
st

4. Cl
NOTE

artup State

e ML-500 Print Server application, 
s in Suspended status by default. If 
n choose to have the Print Server 
ume) status each time you open it.

tup state: 
rver menu select Server 
.

p state, select the status you prefer 
ue to be in each time you open the 
t Server application.
t Server
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om the Server menu select Server 
eferences.

der Folder size limits, specify the amount of 
emory, between 0 (default) and 50000 
egabytes, to allocate to the storage of 
ccessfully printed image files. To receive a 
tification when the storage is full, select Alert 

hen full.

ecify the amount of memory, between 0 and 
000 megabytes (250 is the default), to 

locate to the storage of image files that failed 
 print. To receive a notification when the 
orage is full, select Alert when full.

ick OK.
: Upon reaching the folder size limit, the 

oldest image files will be deleted to make 
room for new image files. If a folder size is 
set to 0, image files will not be saved in that 
folder.

Selecting a St

Upon opening th
the print queue i
you wish, you ca
in Running (Res

To choose a star
1. From the Se

Preferences

2. Under Startu
the print que
ML-500 Prin

3. Click OK.
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Com

Crea

A com
printe

Settin
Enque
Enque
of que
might
a spe

The c
MICR
exten
conta
comm
Allowa
prope
conve
rules)

mand file:
rt menu select Programs, select 
, then select Notepad.

mand lines you wish to use to print 

e menu select Save As.

ation and file name for your file.

hen complete.

ktop or WINDOWS Explorer, 
ile extension from .txt to .kmd.

and file to the ML-500 Print Server, 
 the Source Folder.
ot use the Enqueue command to 

ommand file to the ML-500 Print 
t Server

Back Indexnts Next

mand Files

ting and Printing Command Files

mand file (*.kmd) specifies an image to be 
d and the job settings to apply to that image. 

gs in the command file override settings in the 
ue Print Job window. For example, the 
ue Print Job window might specify one copy 
ued images to be printed. A command file 

 override that setting and print three copies of 
cified image.

ommand file is generally written using 
OSOFT Notepad and saved with the 
sion .kmd rather than .txt. Command files 
in a series of allowable commands that are 
unicated to the ML-500 Print Server (see 
ble command file commands). To work 

rly, command files must adhere to a specific 
ntion and set of rules (see Command file 
.

To create a com
1. From the Sta

Accessories

2. Type the com
your image.

3. From the Fil

4. Choose a loc

5. Click Save w

6. From the des
change the f

To send a comm
copy the file into
NOTE: You cann

send a c
Server.
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Allow

The fo
files:

FIL
the

CO
to 

CU

SH
sh

US
a l

LA
to 

LA
FA
lab

TER_SERIAL_NUMBER: (TRUE 
ether to include printer serial # on 

_NUMBER: (TRUE or FALSE: 
clude job number in label)

TOM_TEXT: (String, 0 to 512 
ustom text to include in the label)

T_COLOR: (CYAN, MAGENTA, or 
l text’s color)

ORDER: (Numeric, 0 to 3000: 
r in pixels)

ORDER: (Numeric, 0 to 3000: 
r in pixels)

RUE or FALSE: whether to center 
rizontally)

SET: (Numeric, 0 to 2560: image 
t in pixels if CENTER is FALSE)
t Server

Back Indexnts Next

able Command File Commands

llowing commands are allowed in command 

ENAME: (String: full (path and file) name of 
 image file)

PIES: (Numeric, 1 to 9999: number of copies 
print)

T: (NO, BETWEEN, or TRIM: cut type)

ARPEN: (NONE, NORMAL, or HIGH: image 
arpening level)

E_LABEL: (TRUE or FALSE: whether to add 
abel)

BEL_FILENAME: (TRUE or FALSE: whether 
include file name on label)

BEL_DATE_TIME_STAMP: (TRUE or 
LSE: whether to include date/time stamp on 
el)

LABEL_PRIN
or FALSE: wh
label)

LABEL_JOB
whether to in

LABEL_CUS
characters: c

LABEL_TEX
BLACK: labe

LEADING_B
leading borde

TRAILING_B
trailing borde

CENTER: (T
the image ho

IMAGE_OFF
left side offse
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PA
us
0 i

PA

PA
an

US
to 

CM
file

CM
FA

CM
file

CM
PE
CO

 Rules

es describe command file 
 convention:
d file specifies an image to be 
 the job settings to apply to that 
y settings are missing, the settings 
 the Server Preferences dialog box 

(*.ros) files contain commands that 
e overridden by the command file.
d file consists of several 
, with one command per line. 
s are also allowed but are ignored.)
d line contains a command (such 
ME:) and a value. The colon 
s optional, and the command can 
se, lowercase, or mixed case. For 
ILENAME:, filename, and 
re all the same command.
t Server

Back Indexnts Next

CKAGE: (Numeric, 0 to 65535: package to be 
ed, 32767 or higher is a Custom package and 
s no package)

CKAGE_SCALING: (Selection, FIT or FILL)

CKAGE _CUSTOM_FILE: (String, full (path 
d file) name of package file)

E_CM: (Selection, TRUE or FALSE: whether 
color image)

_INPUT_PROFILE: (String, full (path and 
) name of the input profile)

_USE_EMBEDDED: (Selection, TRUE or 
LSE: whether to use embedded profile)

_OUTPUT_PROFILE: (String, full (path and 
) name of the output profile)

_RENDERING_INTENT: (Selection, 
RCEPTUAL, SATURATION, or 
LORIMETRIC: rendering intent)

Command File

The following rul
functionality and

✔ A comman
printed and
image. If an
specified in
apply.

NOTE: Rosetta 
cannot b

✔ A comman
commands
(Blank line

✔ A comman
as FILENA
character i
be upperca
example, F
FilenamE a
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✔

✔

NOTE

✔

ion of a command file must be 
e file must be saved as a text file; 
 MICROSOFT Word formats add 
tting information that is not 
 by the ML-500 Print Server and 
rrors.
occurs, error information is written 
ile. It also appears in a dialog if the 
int Server is running in Attended 
t Server

Back Indexnts Next

The set of values allowed depends on the 
command. For example, the COPIES 
command accepts a value between 1 and 
9999. Values, like commands, can be 
uppercase, lowercase, or mixed case. All 
values are of three types: numeric (as in the 
COPIES command), a selection of choices 
(such as No, Between, and Trim for the CUT 
command), or a text string (for the FILENAME 
and LABEL_CUSTOM_TEXT commands).
Spaces or tab characters separate the 
command from its value. Spaces and tabs 
may also be placed before the command or 
after the value. All are ignored.
: Spaces and tabs are allowed in a text string, 

but they cannot be the outermost 
characters, as they are ignored.

If the same command appears more than 
once, the last value is the one that is used.

✔ The extens
".kmd". Th
rich-text or
extra forma
understood
generate e

✔ If an error 
to the log f
ML-500 Pr
mode.
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Samp

The fo
file.
t Server

Back Indexnts Next

le Command File

llowing is an example of a typical command 

FILENAME: H:\Images\Jpg\Birthday_1152x864.jpg
COPIES: 1
CUT: NO
CENTER: FALSE
IMAGE_OFFSET:
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CalibratioOve

Using
contro
made
chang
printe

When

Calibr
✔

✔

✔

rted

alibration Application

alibration icon on the Utility bar.

ation screen appears.
bration

Back Indexnts Next

nrview

 the ML-500 Calibration application you can 
l the color balance and density of the prints 
 with the ML-500 printer. You can verify and 
e the color look-up tables (LUTs) for the 
r.

 to Calibrate the Printer

ate the printer:
Whenever you change a ribbon or a set of 
ribbons, especially when the ribbons have a 
new lot number
When you have a concern about the quality of 
the production prints
As necessary to maintain settings for multiple 
media types.

Getting Sta

Starting the C

✔ Click the C

The Calibr
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Statu

The S
shows

✔

✔

Show

✔

ars at the top of the Calibration 
es shortcuts to functions that you 
gh the menus.

ar

l Bar button to access the 
 function.

g the Tool Bar

iew menu select Tool Bar.

Send LUT
Complete Calibration Cycle

nalyze Target
t Calibration Target
bration

Back Indexnts Next

s Bar

tatus Bar, located at the bottom of the window, 
 the following:

Name of the media used for the current 
calibration event (if one has been selected)
Message appears under the following 
conditions:
Calibration operation taking more than two 
seconds
Rasterizing a calibration target
Printing a calibration target
Sending new LUTs to the printer

ing or Hiding the Status Bar

From the View menu select Status Bar.

Tool Bar

A Tool Bar appe
screen. It provid
can access throu

Using the Tool B

✔ Click a Too
associated

Showing or Hidin

✔ From the V

A
Prin
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Closi

✔

IMPO

Process

iew

ation target (see page 79).

libration target (see page 80).

T to the printer (see page 83).

 the steps separately, as listed 
 all steps at one time by 
plete calibration analysis 

 you select the latter option, some 
alyzing the target are skipped.

 run more than one calibration 
hat the printer's calibration is in 
age 93). 
bration

Back Indexnts Next

ng the Calibration Application

Click the at the upper right of the 
Configuration screen.
RTANT: If you select Exit from the File menu, 

all ML-500 applications close.

Calibration 

Process Overv

1. Print a calibr

2. Analyze a ca

3. Send the LU

You can perform
above, or perform
performing a com
(see page 86). If
of the steps in an

You may need to
cycle to ensure t
tolerance (see p



Cali

Conte 78

Selec

When
you m
startin
startin

✔

✔

calibration: Starts the calibration 
ginning of the last calibration. Use 

if the calibration was in tolerance or 
 in tolerance up until the most 
ration.

d event: Starts the calibration at a 
libration event. Use this option if 
he date and time when the last 
ation was done and you want to 
libration from those settings. If you 
option, an extra dialog box in the 
t Wizard requires you to select the 
 which to start the calibration.
bration

Back Indexnts Next

ting a Calibration Starting Point

 printing a calibration target (see page 79), 
ust select a calibration starting point. Each 
g point serves a different purpose. Use the 
g point that best suits your needs.
Current settings: Starts the calibration using 
the current calibration data. You will use 
Current settings most often. Use Current 
settings if the printer is close to optimal and 
just needs some fine-tuning or if you are 
running a scheduled calibration task.
Factory defaults: Starts the calibration using 
the settings that were shipped with the printer. 
Use this option if calibrating the printer for the 
first time or if the current calibration is 
unacceptable and you would like to make a 
fresh start. 

✔ Redo last 
from the be
this option 
very nearly
recent calib

✔ Designate
specific ca
you know t
good calibr
start the ca
select this 
Print Targe
event from
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Printi

You p
printe
often 
previo
points

When
calibra
the m
is prin
it is re

Before
follow

✔

✔

ation target:
libration menu select Print 
Target.

 Media dialog box, select the media 
then click Next.

 Calibration Starting Point dialog 
 starting point (see page 78), then 
bration

Back Indexnts Next

ng a Calibration Target

rint the calibration target using a defined set of 
r response curves as the starting point. Most 
the starting point is the ending point of the 
us calibration event. Options for other starting 
 exist for special needs.

 you print a calibration target, a specific 
tion event number is created that is related to 

edia and printer. Each target is numbered as it 
ted so that you can refer to the number when 
quested.

 you print the calibration target, check the 
ing:
Is the correct type of media (glossy or matte) 
loaded in the printer?
In the Configuration application, is the 
selected XtraLife ribbon type the same as that 
loaded in the printer (see page 30)?

To print a calibr
1. From the Ca

Calibration 

2. In the Select
to calibrate, 

3. In the Select
box, select a
click Next.
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NOTE

4. Cl

You n
neces
betwe
you ca

alibration Target

 the printed target visually or with a 
eter. Then, you determine if the 

n is acceptable or if the printer 
 from this calibration event should 
atabase and the new LUTs sent to 

t has a unique event number, you 
 a target immediately after you 

 analyze the calibration target, the 
ored in the program and sent to the 

 of new LUTs, or you can ignore 

ps differ slightly depending on the 
urce selected in the Edit 
log box (see page 87).
bration

Back Indexnts Next

: If you select Designated event as a starting 
point, you must select an event number and 
date from the drop-down list on the Select 
Calibration Event dialog box then click 
Next.

ick Finish.

eed not analyze the target immediately. If 
sary, you can exit the calibration application 
en printing and analyzing the target so that 
n resume printing.

Analyzing a C

You can analyze
suitable densitom
current calibratio
response curves
be stored in the d
the printer.

Since each targe
need not analyze
print it. After you
results can be st
printer in the form
the results. 

The analysis ste
measurement so
Configuration dia
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1. Fr
Ca

2. En
th

NOTE

3. Cl

target. You can only use Status A 
rs (see page 92).
al analysis
lly examine the calibration print and 
the cluster number that appears 
neutral (gray).
Next.
lysis on a patch reading 

eter
Next. The Measure Target 
ties dialog box appears.
the RGB values for each target 
The values appear in the dialog 
f necessary, use the cursor to 
 the sequence of the readings, 
ning the highlight row to reread a 

.
Done.
bration

Back Indexnts Next

om the Calibration menu select Analyze 
libration Target.

ter the event number from the target or scan 
e bar code.
: If the event has been completed 

(see page 92), a warning message appears.
ick Next to print the calibration target.

4. Analyze the 
densitomete
✔ For visu

a. Visua
enter 
most 

b. Click 
✔ For ana

densitom
a. Click 

Densi
b. Read 

step. 
box. I
adjust
positio
patch

c. Click 
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✔

✔

 analysis, indicate what to do with 
n data. You must consider whether 
n is in tolerance, and which setting 
 a starting point to determine the 
.
 record the data and consider this 
n complete. This results in the 

on of a new set of LUTs. You may 
se this option if the printer is only 
ut of tolerance and the current 
n appears normal OR if the 
oint was other than Current 

.
: discard the calibration data. The 
ton changes to a Finish button. You 
nly select this option if the printer is 
 tolerance, when the starting point 

rent Settings, and when you do not 
isturb the current printer settings 
edia.
bration

Back Indexnts Next

For analysis on a strip reading 
densitometer
a. Prepare the target for reading in the 

densitometer.
b. Click Next.
For file analysis
a. Read the calibration target and save the 

results to a file.
b. Click Next.
c. Search for and select the file in which 

you saved the target readings.
d. Click OK.

5. Based on the
the calibratio
the calibratio
you used for
proper action
✔ Record:

calibratio
calculati
want to u
slightly o
productio
starting p
Settings

✔ Discard
Next but
should o
clearly in
was Cur
want to d
for the m
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✔

6. Cl
re

NOTE

7. Do
✔

✔

✔

 to the Printer

o the printer makes permanent or 
es to the printer's color settings.

he resulting look up table to the 
 printer is not in use and only when 
rkflow matches the LUT being sent 

just the calibration tolerance level, 
alibration Settings (see page 87). 
bration

Back Indexnts Next

Refine data by calibrating again: allows 
you to perform another iteration of 
calibration, using the calibration LUT 
calculated from the previous calibration as 
the starting point. Use this option if the 
current calibration is out of tolerance and 
you wish to continue calibrating the printer 
to get it within the selected tolerance limits.

ick View Graph to view a graph of the most 
cent calibration data. 
: The View Graph button does not appear if 

you are using visual analysis as there is no 
densitometer data to graph. 

 one of the following:
Click Finish to close the wizard and record 
that the calibration is complete. 
Click Next to continue.
Click Cancel to exit the wizard and wait to 
send the new calibration data to the printer, 
for example, if the printer is busy.

Sending a LUT

Sending a LUT t
temporary chang

You must send t
printer when the
the upcoming wo
to the printer.

If you need to ad
see Changing C
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When phs (see page 91) to see how 
tion target densities are compared 
 aims. The graphs can help you to 
should send the LUT to the printer. 

o the Printer

libration menu select Send LUT to 

ia name from the list, then click 
: If there is only one media name in 
n database, this step is omitted.

ent number and date, then click 

Produ
colors

Calib
tolera

The c
almos
tolera

You w
tempo
adjus

You h
for wh
no LU

The c
tolera
bration

Back Indexnts Next

 to Send a LUT to the Printer You can view gra
close the calibra
to the calibration
determine if you 

To Send a LUT t

1. From the Ca
Printer.

2. Select a Med
Next. NOTE
the calibratio

3. Select an ev
Next.

If Then

ction printing 
 are off

calibrate and then 
immediately send a new LUT 
to the printer.

ration is out of 
nce

send a new LUT to the printer 
immediately after calibration. 

alibration is 
t always out of 
nce

the problem might be 
inherent instability (noise) in 
the system. Select a less 
strict tolerance level in the 
Edit Configuration dialog box.

ant to make 
rary color 

tments

send a new LUT to the 
printer.

ave new media 
ich the printer has 
T

calibrate and send the new 
LUT to the printer. 

alibration is in 
nce

send no LUT and continue 
printing. 
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4. Se
ap
th
bo

5. Ad
G
W
th
th

6. W

After s
prints
correc

ry Color Adjustments

mporary color adjustments to print 
end LUT to the Printer wizard.

 adjustments last until overwritten 
ary or permanent adjustment or 

he printer. 

o make temporary color 

er's images are too yellow 
om outdated film) and the prints 
printed. 
mpaign requires that all the prints 
blue for a unique look.
ot send temporary LUTs to the 

hen using Visual Analysis. Achieve 
 effect by selecting the patch that 

 the adjusted color.
bration

Back Indexnts Next

lect Apply Master Balance if you wish to 
ply a temporary adjustment to the colors for 

is print job. NOTE: The Master Balance dialog 
x does not appear for Visual Analysis.

just the temporary values for Red, Blue, 
reen, and Density and click Next. NOTE: 
hen sending a temporary color adjustment, 
e final dialog box is a different color than all of 
e other dialog boxes in the wizard.

ait until printing stops, then click Finish.

ending a LUT to the printer, you can run test 
 before resuming production to ensure that the 
t LUT was sent.

Making Tempora

You can make te
jobs using the S

Temporary color
by a new tempor
until turning off t

You might want t
adjustments: 

✔ If a custom
(perhaps fr
must be re

✔ If an ad ca
be slightly 

NOTE: You cann
printer w
the same
matches
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To ma
1. Fr

Pr

2. Se
th
in

3. Se
Ne

4. Se
te
jo

5. Ad
G

6. En
Fi
NO
ad
co

omplete Calibration Analysis

plete calibration cycle includes 
lyzing a calibration target.

complete calibration cycle, you 
thing else until the cycle is 

libration menu select Perform 
alibration Cycle.

edia to calibrate, then click Next.

ting point (see page 78).
lect Designated Calibration Event 
ing point, you must select an event 
nd date from the drop-down list. 
 print the calibration target. 

target (see page 80).
bration

Back Indexnts Next

ke temporary color adjustments: 
om the Calibration menu select Send LUT to 
inter.

lect a Media name from the drop-down list, 
en click Next. (If there is only one media type 
 the calibration database, omit this step.)

lect an event number and date, then click 
xt.

lect Apply Master Balance to apply a 
mporary adjustment to the colors for this print 
b.

just the temporary values for the Red, Blue, 
reen, and Density and click Next.

sure that all printing has stopped, then click 
nish in the Send LUT to Printer dialog box. 

TE: When sending a temporary color 
justment, the final dialog box is a different 
lor than the other dialog boxes in the wizard.

Performing a C

Performing a com
printing and ana

If you perform a 
cannot print any
complete. 
1. From the Ca

Complete C

2. Select the m

3. Select a star
NOTE: If you se

as a star
number a

4. Click Next to

5. Analyze the 
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6. Do
✔

✔

✔

Cha

You c
meas
densit
tolera
adjust

it menu select Configuration. 

nge options, as needed. See the 
next page.
bration

Back Indexnts Next

 one of the following:
Click Finish to close the wizard and record 
that the calibration is complete. 
Click Next to continue.
Click Cancel to exit the wizard and wait to 
send the new calibration data to the printer, 
for example, if the printer is busy.

nging Calibration Settings

an change the calibration settings such as the 
urement source, the port where the 
ometer is connected, and the calibration 
nce level. You can also set permanent color 
ments to the prints.

1. From the Ed

2. Select or cha
table on the 
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ave the changes.

Settin

Meas
Sourc

Seria

Meaning

 
Select the check box to use DP2 
with the ML-500. This places a copy 
of the LUTs as files where DP2 can 
use them.

Select a tolerance level of Loose, 
Normal, or Tight. This option is 
disabled if Visual is selected in the 
Measurement Source list.

Select the Media to which you want 
to apply additional color 
adjustments.
Select the appropriate color 
variances for each adjustment of 
Red, Green, Blue, and Density; 
valid values are -100 to 100. The 
measurements are in 0.001 log e 
increments.
These controls are disabled when 
the measurement source is Visual. 
bration

Back Indexnts Next

3. Click OK to s

g Meaning

urement 
e

A measurement source consists of 
the following:

✔ Visual: the target will be 
analyzed visually

✔ Text file: a densitometer 
will record the data and 
you will import a text file

✔ X-RITE DTP-36
✔ X-RITE 404
✔ X-RITE 414
✔ X-RITE DTP-41
✔ X-RITE 528
✔ X-RITE 530

l Port Select the serial port to which the 
densitometer is connected. This is 
disabled if Visual, Remote, or Text 
File is selected in the Measurement 
Source list. 

Setting

DP2 (KODAK 
PROFESSIONAL
Digital Print 
Production 
Software)

Calibration 
Tolerance Level

Update 
calibration 
preferences by 
media
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Wor

Addin

Add n
✔

✔

To ad
1. Fr

se

ia type.

raLife setting, either Glossy or 

ia Width.

dia type is created, the name is 
ia type drop-down lists for the 
bration

Back Indexnts Next

king with Media and Printers

g New Media

ew media:
When the media you want to use is not in the 
database
When adding a new media type

d new media:
om the Calibration menu select New, then 
lect Media.

2. Select a Med

3. Select an Xt
Matte.

4. Select a Med

5. Click OK.

When a new me
added to all med
selected printer.
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Impo

You c
new m
The c
ML-50
does 
calibra

Typica
you im

✔

✔

To im
1. Pl

<i

2. Fr
se

3. Cl

a from the Media List

 is based on the ribbon set, media 
h, and XtraLife settings when you 
here is nothing to edit on the 

t you can remove unused media 

it menu select Media.

edia you want to delete.

. Click Yes or No to confirm.
bration

Back Indexnts Next

rting a Media Type Catalog

an import a new media catalog whenever a 
edia catalog becomes available from Kodak. 

atalog lists all media that can be used by the 
0 printer. Importing a new media catalog 

not change the name of any media or any 
tion history.

lly, the following information is updated when 
port a new media catalog:

type of surface for each media type
printing and calibration aims

port a media catalog:
ace the media catalog file in the 
nstall path>\Cal2000\MDB\ folder.

om the Calibration menu select Import, then 
lect Media Catalog.

ick OK.

Deleting Medi

The media name
type, media widt
add the media. T
media name, bu
from the list.
1. From the Ed

2. Select the m

3. Click Delete

4. Click Done.



Cali

Conte 91

Impo

When
mode
can b
obtain
mode
printe
printe
1. Co

fo

2. Fr
se

libration Data Graphs

 feature provides access to graphs 
libration event data. This feature is 
rything but the Visual measurement 
it Configuration dialog box.
w menu select Graphs.

ia name.

ent number and date.

 view the plot.
st the display based on the Graph 
y Data, and Display Colors.
ck to view a different graph, then 
 event number and date, or click 
se the dialog box.
bration

Back Indexnts Next

rting a Printer Model Catalog

 printer models change or when new printer 
ls are introduced, a new printer model catalog 
e imported. The Calibration application 
s the new printer information from the printer 
l catalog and uses this information for all 
rs of the same type. Kodak may update the 
r model catalog on occasion.
py the new printer model catalog to the 

llowing location: <install path>\Cal2000\MDB\.

om the Calibration menu select Import, then 
lect Printer Model Catalog.

Viewing Ca

The view graphs
generated by ca
available for eve
source in the Ed
1. From the Vie

2. Select a med

3. Click Next.

4. Select an ev

5. Click Next to
You can adju
Type, Displa

NOTE: Click Ba
select an

to clo
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Refe

Com

A com
target
reana

✔

✔

sitometers

rs with a Status A spectral 
e ML-500 calibration application. 
ith a Status T spectral response 
r the ML-500 calibration 

nsitometers are usable with the 
ation: 

4 *
4 *
T-36
T-41
8
0

nd 414 densitometers marked with 
able with the calibration 
bration

Back Indexnts Next

rence

pleted Calibration Event

pleted calibration event is any calibration 
 that has been printed and analyzed. You can 
lyze a target if the following are true:
The calibration target was analyzed visually.
There have been no other calibrations 
completed for the printer and media 
combination since the one that you want to 
analyze.

Approved Den

Use densitomete
response with th
Densitometers w
are unsuitable fo
application. 

The following de
calibration applic

✔ X-RITE 40
✔ X-RITE 41
✔ X-RITE DP
✔ X-RITE DP
✔ X-RITE 52
✔ X-RITE 53

* Only the 404 a
"A-RESP" are us
application.



Cali

Conte 93

Calib

The c
within
accep

There
you ca
repea

✔

✔

✔

bration

Back Indexnts Next

ration Tolerance Level

alibration tolerance level defines the range 
 which a target must fall to be considered 
table.

 are three options for tolerance from which 
n choose based on the accuracy and 

tability of the densitometer and printer:
Loose: Use if you may be redoing the 
calibration needlessly because of inherent 
statistical noise in the system. 
Normal: Use for all your calibrations, unless 
you are frequently recalibrating your printer, 
especially if you are recalibrating and the 
prints look good.
Strict: Use only if you can demonstrate that 
your printing system's inherent variability does 
not cause needless recalibration, and your 
output product demands very tight density 
control. 
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Printer D

Printe
printe

Printe
are in
ML-50

✔

✔

✔

The p
install
ML-50
driver
applic

r Management (ICM)

nagement (ICM) is a MICROSOFT 
r management tool that is part of 
perating systems. ICM lets you 
 on your monitor with the colors on 
. 

WS documentation for complete 
ow to use ICM.
ter Drivers

Back Indexnts Next

rivers

r drivers are used to print to the ML-500 
r from applications on your system.

r drivers for the following operating systems 
cluded on the KODAK PROFESSIONAL 
0 Digital Photo Print System CD:

WINDOWS 2000 / WINDOWS XP
WINDOWS 98/ME
MACINTOSH OS X

rinter driver for your operating system must be 
ed (see page 7) before you can print from 
0 Utilities. In addition, you can use the printer 

 to access the ML-500 printer from other 
ations such as ADOBE PHOTOSHOP.

Image Colo

Image Color Ma
WINDOWS colo
the WINDOWS o
match the colors
the printed page

See your WINDO
instructions on h
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WIN
Ope

Rem

1. Fr
se

2. Se

3. Fr

4. Cl

 Printing Preferences Screen

s the Printing Preferences screen 
t menu, you can change settings 
ll applications.

s the Printing Preferences screen 
ile from an application, you can 
for that print job only.
ter Drivers

Back Indexnts Next

DOWS XP / WINDOWS 2000 
rating Systems

oving a Printer Driver

om the Start menu select Settings, then 
lect Printers.

lect the ML-500 printer.

om the File menu select Delete.

ick Yes for the prompt.

Displaying the

When you acces
through the Star
for print jobs in a

When you acces
while printing a f
change settings 
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To Ch

1. Fr
se

2. Ri
Pr

To Ch

1. Fr

2. Ri
Pr

Layin

You c
your d
1. Di

(s

out tab.

ientation.
ter Drivers

Back Indexnts Next

ange Settings for All Print Jobs

om the Start menu select Settings, then 
lect Printers.

ght-click the ML-500 printer and select 
inting Preferences.

ange Settings for the Current Print Job

om the File menu select Print.

ght-click the ML-500 printer and select 
inting Preferences.

g Out the Page

an select portrait or landscape orientation for 
ocument page.
splay the Printing Preferences screen 
ee page 95).

2. Click the Lay

3. Select the or

4. Click OK.
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Scalin

You c
perce
1. Di

(s

2. Cl

ced.

ocument Options, Printer 
necessary.

sired scaling percentage.
ter Drivers

Back Indexnts Next

g a Document Page

an scale a document page by a specified 
ntage between 10% and 400%.
splay the Printing Preferences screen 
ee page 95).

ick the Layout or Paper/Quality tab.

3. Click Advan

4. Expand the D
Features, if 

5. Select the de

6. Click OK.
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Crea

You c
WIND
when 
1. Fr

se

2. Fr
or
se
.

rms tab then select the Create a 
heck box.
ter Drivers

Back Indexnts Next

ting a Custom Form

an create a custom paper size using 
OWS functionality, then select the paper size 
you print using the ML-500 driver.
om the Start menu select Settings, then 
lect Printers.

om the File menu select Server Properties 
 right-click an open area in the window and 
lect Server Properties.

3. Select the Fo
New Form c
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4. En
O
cm
m

5. Cl

 form from an application:
e menu select Print.

e ML-500 printer, select 
then click Advanced.

stom paper size from the Paper 
wn list, then click OK.
ter Drivers

Back Indexnts Next

ter the Form Description and Paper Size.
ne of the dimensions must be 8.53 in. (21.67 
). The left, right, top, and bottom margins 

ust all be 0.00.

ick OK.

To Use a custom
1. From the Fil

2. Right-click th
Properties, 

3. Select the cu
Size drop-do
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Using

With p
page 
sizes 
packa
print c
print, 
upon 

The p
aspec
To fill 
the im

You c
✔

✔

✔

Printing Packages

 make sure that the image in the 
ish to print is the same size as the 
t page in the package. For 
elect the package "5 x 7 in. and 
allets," the image on your original 

should be 5 x 7 in. If necessary, 
 on the document page in an 
 as ADOBE PHOTOSHOP before 

rinting Preferences screen 
).

out or Paper/Quality tab.

ced.
ter Drivers

Back Indexnts Next

 Package Printing

ackage printing, you send a single document 
to the printer and get multiple document page 
on your print. For example, if you select the 
ge "5 x 7 in. and 3.5 x 5 in. and Wallets," your 
ontains one 5 x 7 in. print, one 3.5 x 5 in. 
and a number of wallet size prints (depending 
the paper size selected). 

rint sizes may not be exact because of the 
t ratio of the images on the document page. 
the entire print area, you may need to resize 
ages on the document page before printing.

an:
Use standard printing packages
Create custom printing packages 
(see page 127)
Use custom printing packages (see page 102)

Using Standard 

For best results,
document you w
largest documen
example, if you s
3.5. x 5 in. and W
document page 
resize the image
application such
printing. 
1. Display the P

(see page 95

2. Click the Lay

3. Click Advan
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4. Se
th

NOTE

5. Cl

kages tab.

ge as the Print format.

p-down list, select a standard 
ter Drivers

Back Indexnts Next

lect the 8.5 x 14 in. paper size. You must use 
is size for all standard packages. 
: Custom packages may require different 

paper sizes.
ick OK.

6. Click the Pac

7. Select Packa

8. From the dro
package.

9. Click OK.
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Using

To cre
see p
1. Di

(s

2. Cl

3. Se

4. Cl

5. In
pa
an
th

NOTE

6. Cl
Th
ac

y page size mismatch messages. If 
elect a different page size.

of a custom package fits on the 
 image is outlined in red, and a 
rs indicating that some images in 
age file are off the page.
ter Drivers

Back Indexnts Next

 Custom Printing Packages

ate a custom printing package or layout, 
age 127.
splay the Printing Preferences screen 
ee page 95).

ick the Packages tab. 

lect Package as the Print format. 

ick Browse.

 the file selection box, locate the custom 
ckage file you wish to use, or select the last 
d most recently used custom package file at 
e bottom of the drop-down package list.
: If a custom package has never been 

created, then a custom package file will not 
appear in the list.

ick OK.
e preview window changes to represent the 
tual custom package layout.

7. Check for an
necessary, s

If only a portion 
page, the partial
message appea
the custom pack
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Cuttin

W
T
in
p

1. Di
(s

2. Cl

3. Cl

4. Ex
if 

, select an option. (See page 31.)
ter Drivers

Back Indexnts Next

g Prints

ARNING:
he cutter is very sharp and can cause 
jury. Stay away from the cutter when the 
rinter is running.

splay the Printing Preferences screen 
ee page 95).

ick the Layout or Paper/Quality tab.

ick Advanced.

pand Document Options, Printer Features, 
necessary.

5. Under Cutter

6. Click OK.
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Addin

1. Di
(s

2. Cl

3. Cl

select the file for your logo.
 must be either an uncompressed 
) or a bitmap (.bmp) file.
ress the logo file. If you select a 

 file, a message appears indicating 
r is unable to read the logo file and 

ormat is incorrect.

pen and read the file.

ears in the Logo preview window.

 

ter Drivers

Back Indexnts Next

g a Logo to a Page

splay the Printing Preferences screen 
ee page 95).

ick the Logo tab.

ick Browse.

4.  Locate and 
NOTE: The logo

TIFF (.tif
Do not comp
compressed
that the drive
that the file f

5. Click OK to o

6. Click OK.
The logo app

7. Click Apply.
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WIN
Syst

Displ

s the Properties screen through the 
 can change settings for print jobs 
s.

s the Properties screen while 
m an application, you can change 
print job only.

ngs for All Print Jobs

rt menu select Settings, then 
rs.

e ML-500 printer and select 

ngs for the Current Print Job

e menu select Print.

e ML-500 printer and select 
ter Drivers

Back Indexnts Next

DOWS 98/ME Operating 
ems

aying the Properties Screen

When you acces
Start menu, you
in all application

When you acces
printing a file fro
settings for that 

To Change Setti

1. From the Sta
select Printe

2. Right-click th
Properties.

To Change Setti

1. From the Fil

2. Right-click th
Properties.
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Layin

You c
1. Di

2. Cl

ientation (Portrait or Landscape).

sired scaling percentage 
).
ter Drivers

Back Indexnts Next

g Out the Page

an select the orientation for your page.
splay the Properties screen (see page 95).

ick the Layout tab.

3. Select the or

4. Select the de
(10% - 400%

5. Click OK.
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Using

With p
page 
sizes 
packa
print c
print, 
upon 

The p
aspec
To fill 
the im

You c

Us

Cr
(se

Us

Printing Packages

r a description of standard printing 

roperties screen (see page 95).

dia tab.
ter Drivers

Back Indexnts Next

 Package Printing

ackage printing, you send a single document 
to the printer and get multiple document page 
on your print. For example, if you select the 
ge "5 x 7 in. and 3.5 x 5 in. and Wallets," your 
ontains one 5 x 7 in. print, one 3.5 x 5 in. 
and a number of wallet size prints (depending 
the paper size selected). 

rint sizes may not be exact because of the 
t ratio of the images on the document page. 
the entire print area, you may need to resize 
ages on the document page before printing.

an:

e standard printing packages (see page 100)

eate custom printing packages 
e page 127)

e custom printing packages (see page 102)

Using Standard 

See page 100 fo
packages.
1. Display the P

2. Click the Me
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3. Se
th

IMPO

4. Cl

5. Cl

6. Se

p-down list, select a standard 
ter Drivers

Back Indexnts Next

lect the 8.5 x 14 in. paper size. You must use 
is size for all standard packages. 
RTANT: You must use this size for all 

standard packages.
ick Apply.

ick the Layout tab.

lect Package as the Print format.

7. From the dro
package.

8. Click OK.
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Using

To cre
see p
1. Di

2. Cl

3. Se

4. Cl

5. In
pa
re
of

NOTE

6. Cl
Th
ac

y page size mismatch messages. If 
elect a different page size.

of a custom package fits on the 
 image is outlined in red, and a 
rs indicating that some images in 
age file are off the page.
ter Drivers

Back Indexnts Next

 Custom Printing Packages

ate a custom printing package or layout, 
age 127.
splay the Properties screen (see page 95).

ick the Layout tab. 

lect Package as the Print format. 

ick Browse.

 the file selection box, locate the custom 
ckage file (.kpg) or select the last and most 
cently used custom package file at the bottom 
 the drop-down package list.
: If a custom package has never been 

created, then a custom package file will not 
appear in the list.

ick OK.
e preview window changes to represent the 
tual custom package layout.

7. Check for an
necessary, s

If only a portion 
page, the partial
message appea
the custom pack
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Cuttin

W
T
in
p

1. Di

2. Cl

3. Ne

4. Cl

 to a Page

roperties screen (see page 95).

o tab.
ter Drivers

Back Indexnts Next

g Prints

ARNING:
he cutter is very sharp and can cause 
jury. Stay away from the cutter when the 
rinter is running.

splay the Properties screen (see page 95).

ick the Media tab.

xt to Cutter, select an option. (See page 31.)

ick OK.

Adding a Logo

1. Display the P

2. Click the Log



Prin

Conte 111

3. Cl

4.  L
NOTE

Do
co
th
th

5. Cl

6. Cl
Th

H Operating System

ent is built into the MACINTOSH 
 is always used.

 Page

ment. From the File menu select 
 to display the Page Setup dialog 
ter Drivers

Back Indexnts Next

ick Browse.

ocate and select the file with your logo.
: The logo must be either an uncompressed 

TIFF (.tif) or a bitmap (.bmp) file.
 not compress the logo file. If you select a 
mpressed file, a message appears indicating 
at the driver is unable to read the logo file and 
at the file format is incorrect.

ick OK to open and read the file.

ick OK.
e logo appears in the Logo preview window.

MACINTOS

Color managem
printer driver and

Laying Out the

1. Open a docu
Page Setup
box.
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2. Fr
At

3. Fr

4. Fr
✔

✔

✔

✔

Cu
lis
Th

5. In
✔

✔

✔

6. In

7. Cl

 Paper Size

ure is available only in MAC OS 
d higher.

ttings menu in the Page Setup 
ee page 111), select Custom 

e for the Custom Paper Size.

 for Height, Width, and for the 
ins. 

page size is now accessible from 
ze menu.
ter Drivers

Back Indexnts Next

om the Settings menu select Page 
tributes.

om the Format for menu select ML-500.

om the Paper Size menu, select an option: 
8.5 x 7 in. (216 x 178 mm) 
8.5 x 11 in. (216 x 279 mm) 
8.5 x 12 in. (216 x 305 mm) 
8.5 x 14 in. (216 x 355 mm) 

stom papers are included at the bottom of the 
t.
e default setting (as shipped) is 8.5 x 11 in.

 the Orientation section, select an option:
Portrait
Landscape
Reversed Landscape 

 the Scale window, enter a value (1 to 100%).

ick OK.

Adding a Custom

NOTE: This feat
10.2.3 an

1. From the Se
dialog box (s
Paper Size. 

2. Click New. 

3. Enter a nam

4. Enter values
Printer Marg

5. Click Save. 
The custom 
the Paper Si
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Using

1. O
Pr

sired panel from the list.
ter Drivers

Back Indexnts Next

 the Print Dialog Box

pen a document. From the File menu select 
int.

2. Select the de
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 T
✔

✔

✔

✔

✔

✔

✔

3. Ch

4. Cl

mary of Print Settings

t dialog box (see page 113), select 
ary panel.
t settings are displayed.
ter Drivers

Back Indexnts Next

he following panels are available
Copies & Pages
Layout
Output Options
Logo
Printer Options
Packages
Summary

ange settings, as needed.

ick Print.

Viewing a Sum

✔ On the Prin
the Summ
The curren
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Addin

1. O
th

ogo. 

 

e for your logo
 must be PICT file.

ears in the Logo preview window. 
Logo
rtical and horizontal position, enter 

0 to 100.
osition: 0 = top edge of the 

le area; 100 = bottom edge
al Position: 0 = left edge of the 
le area; 100 = right edge
ter Drivers

Back Indexnts Next

g a Logo to a Page

n the Print dialog box (see page 113) select 
e Logo panel.

2. Check Use L

3. Click Select.

4. Select the fil
NOTE: The logo
5. Click Open.

The logo app
Placing the 
To change ve
values from 
✔ Vertical P

imageab
✔ Horizont

imageab
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 E
✔

Ed
✔

6. Cl
Th
pa

Notes
✔

✔

ptions

ptions Panel you can select the 
ct cutting options for the printer, 
ts.
ter Drivers

Back Indexnts Next

diting Opacity
To edit the opacity of the logo, enter a value 
from 1 to 100% (the larger the percentage, 
the greater the opacity).

iting Scale
To edit the scale of the logo, enter a value 
from 1 to 400% (or until the image exceeds 
the imageable area, whichever comes first).

ick Print.
e position of the logo (relative to the printed 
ge) appears in the Layout preview window. 

:
 Because the logo is applied to the image after 
ICC color management, the logo is not color 
managed.
Because the logo is applied to the image after 
"Pages per Sheet" is applied, the logo is not 
applied to individual pages on the sheet.

Using Printer O

On the Printer O
paper finish, sele
and sharpen prin
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Choos

1. O
th

2. Se

3. Se
✔

✔

is very sharp and can cause 
 away from the cutter when the 
nning.

dialog box (see page 113) select 
ptions panel (see page 116).

tter pull-down menu.

tion (see page 31).

ult setting (as shipped) is 1 cut 
 prints).
ter Drivers

Back Indexnts Next

ing Glossy or Matte

n the Print dialog box (see page 113) select 
e Printer Options panel (see page 116).

lect the XtraLife menu. 

lect an option: 
Glossy – invokes the "gloss" ICM profile in 
the print job
Matte – invokes the "matte" ICM profile in 
the print job 

Cutting Prints

WARNING:
The cutter 
injury. Stay
printer is ru

1. On the Print 
the Printer O

2. Click the Cu

3. Select an op

4. Click Print.
NOTE: The defa

(separate
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ts

dialog box (see page 113) select 
ptions panel (see page 116).

rpen pull-down menu.

tion: 
no sharpening in the print job 
– normal sharpening in the print job
igh sharpening in the print job

ult setting (as shipped) is Normal 
ng.
ter Drivers

Back Indexnts Next

Sharpening Prin

1. On the Print 
the Printer O

2. Click the Sha

3. Select an op
✔ None – 
✔ Normal 
✔ High – h

4. Click Print.
NOTE: The defa

sharpeni
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Using

With p
page 
sizes 
packa
print c
print, 

The p
aspec
To fill 
the im

You c
✔

✔

✔

Printing Packages

r a description of standard printing 

5 x 14 paper size is selected 
1).
u must use this size for all 
ndard packages.
ter Drivers

Back Indexnts Next

 Package Printing

ackage printing, you send a single document 
to the printer and get multiple document page 
on your print. For example, if you select the 
ge "5 x 7 in. and 3.5 x 5 in. and Wallets," your 
ontains one 5 x 7 in. print, one 3.5 x 5 in. 
and a number of wallet size prints. 

rint sizes may not be exact because of the 
t ratio of the images on the document page. 
the entire print area, you may need to resize 
ages on the document page before printing.

an:
Use standard printing packages 
(see page 119)
Create custom printing packages 
(see page 127)
Use custom printing packages 
(see page 120)

Using Standard 

See page 100 fo
packages.
1. Verify that 8.

(see page 11
IMPORTANT: Yo

sta
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2. O
th

3. Fr
st

4. Cl

rinting Packages

m printing package, see page 127.
dialog box (see page 113) select 
 panel.

Custom Package.

stom package file you wish to use. 
m package has previously been 

, it appears at the bottom of the list. 

 window changes to represent the 
 package layout.

of a custom package fits on the 
 image is outlined in red, and a 
rs indicating that some images in 
age file are off the page.
ter Drivers

Back Indexnts Next

n the Print dialog box (see page 113) select 
e Packages panel.

om the Package drop-down list, select the 
andard package you wish to use.

ick Print. 

Using Custom P

To create a custo
1. On the Print 

the Package

2. Click Select 

3. Select the cu
NOTE: If a custo

selected
4. Click Print. 

The preview
actual custom

If only a portion 
page, the partial
message appea
the custom pack
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Getting H

In add
resou
Utilitie

✔

✔

✔

✔

✔

e Help

 for the following:
ilities
r

ion
r drivers

 Help system for each application 
nsitive help for window items.

0 Utilities has been opened, then 
stem is accessible. If the 
rint Server, or Calibration 
e also been opened, then the Help 
urrent window (see page 23) and 

ies are accessible. For example, if 
 application is current, its Help 
ible.
ting Help

Back Indexnts Next

elp

ition to this User’s Guide, the following 
rces provide information about the ML-500 
s:
Online Help
KODAK PROFESSIONAL ML-500 Digital 
Photo Print System CD contains printable and 
multimedia documentation
KODAK PROFESSIONAL ML-500 Digital 
Photo Print System Web site:
http://www.kodak.com/global/en/service/softw
are/ML500/ml500Software.jhtml 
Frequently asked questions: 
http://www.kodak.com/global/en/service/profe
ssional/products/ekn017852.jhtml?id=0.3.26.
6.18&lc=en then select Frequently Asked 
Questions.
Technical support (1-800-235-6325)

Using Onlin

Help is available
✔ ML-500 Ut
✔ Print Serve
✔ Calibration
✔ Configurat
✔ Most Printe

You can view the
or get context-se

If only the ML-50
only that Help sy
Configuration, P
applications hav
systems for the c
the ML-500 Utilit
the Configuration
system is access

http://www.kodak.com/global/en/service/professional/products/ekn017852.jhtml?id=0.3.26.6.18&lc=en
http://www.kodak.com/global/en/service/professional/products/ekn017852.jhtml?id=0.3.26.6.18&lc=en
http://www.kodak.com/global/en/service/professional/products/ekn017852.jhtml?id=0.3.26.6.18&lc=en
http://www.kodak.com/global/en/service/professional/products/ekn017852.jhtml?id=0.3.26.6.18&lc=en
http://www.kodak.com/global/en/service/professional/products/ekn017852.jhtml?id=0.3.26.6.18&lc=en
http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml
http://www.kodak.com/global/en/service/software/ML500/ml500Software.jhtml
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View

With t
as de
1. In

ap
Fo
Co

tents, Index, or Search tabs to 
he desired Help topic.
ting Help

Back Indexnts Next

ing a Help System

he exception of the Printer Drivers, view Help 
scribed below:
 the current window, select the Help for that 
plication from the Help menu.
r example, from the Help menu select 
nfiguration Help, then select Help Topics.

2. Use the Con
navigate to t
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Viewin

WIND
1. In

m

2. Se

3. Cl

MACI
✔

 Sensitive Help

llowing to view a description of a 

 a window item (for example, a 
t item) then click the What’s This? 

1 key for information about a 
 window item.

t dialog box, click the button.
ting Help

Back Indexnts Next

g Help for Printer Drivers

OWS:
 any application, select Print from the File 
enu.

lect the ML-500 printer then click Properties.

ick the Help button.

NTOSH:
Launch the Help Center and select ML-500 
Help.

Using Context

WINDOWS:

Do one of the fo
window item:

✔ Right-click
button or lis
popup.

✔ Press the F
highlighted

MACINTOSH:
✔ On the Prin
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Troubles

son for Error

Mess
ribbon

o the ML-500 Operator’s Guide):
screwed in completely?
roperly?
perly?
roperly over all of the rollers?

No so
instal

r application before installing the port 
e folder has been created 
ing the port monitor.

Image 533 in. / 21.67 cm. and/or longer than 
 fit on the page even if the offset is set 

Image 0 lines (1/2 in. / 1.27 cm.) long.

Offse e paper width but it would fit if the 

Incom  the following formats: JPEG (*.jpg), 

Invali  is corrupt or otherwise unusable.
bleshooting

Back Indexnts Next

hooting

Error Message or Problem Rea

age indicates that the ML-500 is out of 
 

Check the following (Refer t
✔ Is the platen assembly 
✔ Is the ribbon installed p
✔ Is the ribbon wound pro
✔ Is the paper threaded p

urce folder appears during port monitor 
lation

You must run the Print Serve
monitor. Verify that a Sourc
(see page 44) before install

 Too Large The print job is wider than 8.
37 ft / 11.2776 m and will not
to zero.

 Too Small The print job is less than 15

t Too Large The print job is wider than th
offset was smaller.

patible File Format Image file must be in one of
TIFF (*.tif), Rosetta (*.ros).

d Color Management Profile A color management profile
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Drive ressed. They can be uncompressed 

Job is edit a print job, printing is suspended. 
ing resumes automatically.

Can’t
driver hed correctly? (Refer to the ML-500 

r in the list of available printers in the 

r?
opriate print settings?

Artifa bon folding.
 lot number
a matte ribbon, try a glossy ribbon to 
.

Error 
white dition installed on the server can 

e page 1 for system requirements for 

firmware version? See page 34.

son for Error
bleshooting

Back Indexnts Next

r can’t read logo file. Format is incorrect. Logo files must not be comp
TIFF (.tif) or bitmap (.bmp).

n’t printing or blank sheet is printed When you move, delete, or 
Complete the task and print

 print from application using the printer Check the following:
✔ Are all the cables attac

Operator’s Guide.)
✔ Does the printer appea

Print dialog box?
✔ Did you select the drive
✔ Did you select the appr

ct appears in prints (lead edge fold) This may be caused by a rib
Try a ribbon with a different
If the problem appears with 
see if the artifact disappears

# 1001, 1005, or 1023 appears or blank 
 space appears in prints.

Check the following:
✔ WINDOWS XP Home e

cause this problem. Se
the server system.

✔ Do you have the latest 

Error Message or Problem Rea
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When
8.5 x 
printe

), select Page Setup. from the File 
inter, and select a new page size.

Custo
drop-

t be 8.53 in. (21.67 cm).

son for Error
bleshooting

Back Indexnts Next

 printing from ADOBE PHOTOSHOP, 
14 images are cropped or blank pages are 
d.

To resolve (in PHOTOSHOP
menu, select the ML-500 pr

m form does not appear in the Paper Size 
down list (see page 99).

One of the dimensions mus

Error Message or Problem Rea
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AppendixCrea
or L

You m
templ
and th
units f
want t
When
templ
NOTE

in the job, use pixels to indicate:
om the left side of the paper's 
rea to the left side of the image
om the top of the paper's printable 
 top of the image
 image
e image
endix A

Back Indexnts Next

 A:               Appendix Ating Custom Printing Packages 
ayouts

ay create a custom package or layout 
ate file using any word processing application 
en save it as a text file. Use pixels as the 
or the image size, and specify where you 
he images to appear on the printed page. 
 you print your job, select the custom package 
ate file, and apply it to your print job.
: Use the sample files on the CD that was 

shipped with the ML-500 printer as 
examples for creating your custom package 
template files.

For each image 
✔ distance fr

printable a
✔ distance fr

area to the
✔ width of the
✔ length of th
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Speci

Use th
for the

Type:

Versio

#<com

x1,y1,

x2,y2,

xN,yN
✔

✔

✔

 designates the beginning of a 
The end of a comment is indicated 
(End of Line, the Enter or Return 

ents can appear anywhere.
left corner of image N is identified 
s referenced from the 0,0 datum of 

le area of the page.
sions of image N are in integers 
y xdimN, ydimN with no integers at 
s than 6.
y values are non-negative integers 
by commas.
 an image specification is indicated 
(End of Line, the Enter or Return 

lude at least one complete image in 
endix A

Back Indexnts Next

fications for creating a template file

e following format to define the placeholders 
 images in your custom template: 

 KPKG<EOL>

n 1.0<EOL>

ments><EOL>

xdim1,ydim1<EOL>

xdim2,ydim2<EOL>

,xdimN,ydimN<EOL>
The Type field requires the 4 characters 
KPKG.
The Version field requires the 2 digits 
separated by a single decimal (1.0 in the 
example).
Use pixel units for image locations and 
dimensions.

✔ The # sign
comment. 
by <EOL> 
key). Comm

✔ The upper 
by xN, yN a
the printab

✔ The dimen
identified b
a value les

✔ The x and 
separated 

✔ The end of
by <EOL> 
key).

✔ Always inc
the file.
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Glossary
Aim

The
Clien

Rem
the 
ML-
WIN
be i

Comm
Spe
sett

Gloss
A s
pap

Hot fo
See

Layou
A s
pag

t) where actions performed by the 
erver are recorded.

 let the printer compensate for 
dia and in the printer to keep your 

ently operating at the same color 
k-up tables are created by 
 desired density response for the 
orm of aims, the current calibration 
e calibration image information.

able.

t coats the top surface of the 

ains data about the types of media 
 use. This includes some data 
ia that does not affect calibration. 
ssary

Back Indexnts Next

Glossary

 desired response of the printer.
t systems

ote computer systems that are networked to 
server system that is connected to the 
500 printer. If you will be using the ML-500 
DOWS printer driver to print, the driver must 

nstalled on the client systems.
and file (*.kmd)

cifies an image to be printed and the job 
ings to apply to that image. 
y

hiny finish that coats the top surface of the 
er.
lder
 Source folder.
t

ingle print with multiple copies of the same 
e size, for example two 4 x 6 in. prints.

Log file
A text file (*.tx
ML-500 Print S

Look-up table 
Look-up tables
changes in me
printer consist
response. Loo
combining the
printer in the f
curves, and th

LUT
See Look-up t

Matte
A flat finish tha
paper.

Media catalog
A file that cont
the printer can
about the med
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Media
The
med
type

Packa
A s
for 
prin

Printe
The
prin
info

Print 
A b
in th
file 
how
the 

Print 
The
prin

umber of copies, the type of image 
t status, and the file source.

y the printer drivers.

nnected to the ML-500 printer is 
 server system. The ML-500 
 are installed on this system. If you 
e ML-500 WINDOWS driver to 

monitor and the printer driver(s) 
led on the server before installing 
ers on the client systems.

lder is a folder that you designate 
ge files. Image files placed within 

be automatically sent to the print 
 jobs.

eating custom printing packages or 
plate defines size and position of 
or images.
ssary

Back Indexnts Next

 name
 media name is a combination of several 
ia properties: ribbon set, paper type, XtraLife 
 (glossy or matte), and media width.
ge

ingle print with multiple document page sizes, 
example, one 5 x 7 in. print, one 3.5 x 5 in. 
t, and a number of wallet size prints.
r control panel
 display panel on the front of the ML-500 
ter that provides printer status and error 
rmation.
job
lock of information that is assigned a number 
e print queue. It is a combination of an image 

and its specific settings, which tells the printer 
 to print the image. Print jobs are printed in 
order they were added to the print queue.
queue
 print queue is a list of print jobs awaiting 
ting. For each job number, the print queue 

displays the n
file, the curren

Rosetta file
Files created b

Server systems
The system co
considered the
Printer Utilities
will be using th
print, the port 
must be instal
the printer driv

Source folder
The Source fo
for printing ima
this folder will 
queue as print

Template file
Used when cr
layouts, a tem
placeholders f
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A
addin
addin
addin

(M
analyz
arrang
attend

B
before
before
borde

C
calibra

ana
ana
cha
com
prin
pro
sele
sett
tole
view

ate, 75
cation

 hiding, 76

hiding, 76

t

91
rce folder, 44

plication, 77
application, 26
ations, 22
pplication, 43
s, temporary, 85
nt, using, 58
0
mands, 71
rinting, 70
x

Backnts Next Index

g a logo to a page, 104, 110, 115
g media, 89
g the ML-500 printer to the printer list 

ACINTOSH), 19
ing a calibration target, 80
ing open applications, 23
ed printing, 66

 you can print (MACINTOSH), 17
 you can print (WINDOWS), 15
rs, adjusting on prints, 57

tion
lysis (complete), performing, 86
lyzing a target, 80
nging settings, 87
pleted event, 92
ting a target, 79
cess, 77
cting a starting point, 78
ings, changing, 87
rance level, 93
ing data graphs, 91

when to calibr
Calibration appli

closing, 77
starting, 75
Status bar

showing and
Tool bar, 76

showing or 
using, 76

calibration targe
analyzing, 80
printing, 79

catalog
media type, 90
printer model,

changing the sou
closing

Calibration ap
Configuration 
ML-500 applic
Print Server a

color adjustment
color manageme
command files, 7

allowable com
creating and p
example, 74
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rule
comp
comp
Config

clos
refr
star
Sta

s
copies
cutter

cho
cutter

adju
cutting

D
date a
deletin
densit
deque
disk s
driver

inst
driver

tion for calibration, 87
r list, 34
ices (MACINTOSH), 18

wing, 36
tilities, 24

ading, 34

 space for, 68

s, 68
65

91

ive, 123
ers, 123
36
x

Backnts Next Index

s, 72
lete calibration analysis, 86
leted calibration event, 92
uration application
ing, 26

eshing the screen, 26
ting, 25
tus bar, 26
howing or hiding, 26
, selecting the number to print, 54

osing default settings, 31
 and print head
sting registration, 32
 prints, 103, 110, 117

nd time, setting, 28
g media from the media list, 90
ometers, approved, 92
ueing a job, 62
pace, allocating for print job folders, 68
s and port monitor
alling, 7
s. see printer drivers, 94

E
editing configura
editing the printe
enabling file serv
error history, vie
exiting ML-500 U

F
file, log, 44
firmware, downlo
folders

allocating disk
failed jobs, 68
source, 44
successful job

forcing printing,

G
graphs, viewing,

H
help, 121

context sensit
for printer driv

history, viewing,
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I
ICM, 9
identif
Image
impor

med
prin

install
ML-
por
por

L
labelin
langu
layout
log file
logo, 
LUT

sen
m

whe

M
MACI

prin

 the client, 14
ments, 7

inter driver
vers, 111

tus, checking, 36
s, 35
edia list, 90

ng, 37
old, setting, 29

og, importing, 90
ions

25
1

20

ments, 1

er (WINDOWS), 15
x

Backnts Next Index

4
ication information for printer, 35
 Color Management, 94

ting
ia type catalog, 90
ter model catalog, 91
ing
500 Utilities, 1
t monitor and drivers, 7
t monitor on the server, 8

g prints, 56
age, selecting for printer control panel, 27
 or package, selecting, 58
, setting up, 44

adding to a page, 104, 110, 115

ding to printer, 83
aking temporary color adjustments, 85
n to send to printer, 84

NTOSH
ter driver

installing on
system require

MACINTOSH pr
see printer dri

media
adding, 89
and printer sta
checking statu
deleting from m
supply, checki

media low thresh
media type catal
ML-500 applicat

closing, 22
Configuration,
Print Server, 4
starting, 22

ML-500 Utilities,
exiting, 24
installing, 1
starting, 20
system require

N
naming the print
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O
online
orient
overv

Cal
Prin
prin

P
packa

crea
stan
usin

p
packa
paper

adju
paper
paper
port m

inst
port m

inst
power
print h

adju
print j

ally, 47
e order, 63
 queue, 62

5
bs, 63
 from, 62
8

lication

 hiding, 42

s, 36
e, 37
35

ate, 75
a status, checking, 36
x

Backnts Next Index

 help, 121
ation, selecting, 112
iew
ibration, 75
t Server, 25
ting, 45

ge and layout printing, 100, 107, 119
ting custom printing packages, 127
dard printing packages, 100, 107, 119
g custom printing 
ackages, 61, 102, 109, 120
ge or layout, selecting, 58
 cutter and print head
sting registration, 32

 cutting boundaries, choosing, 55
 type, selecting, 30
onitor
alling on the server, 8
onitor and drivers

alling, 7
 saver, setting, 29
ead and paper cutter
sting registration, 32

ob settings, 48

changing, 52
print jobs

creating manu
rearranging th
removing from

print queue
adding jobs, 4
rearranging jo
removing jobs
setting limits, 6

Print Server app
closing, 43
overview, 25
starting, 41
Status bar, 42

showing and
Tool bar, 43

using, 43
printer

checking statu
checking usag
identification,
selecting, 23
when to calibr

printer and medi
printer drivers

MACINTOSH
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a
c
c
la
p
s
u
v

WIN
c
d
la
p

WIN
a
c
d
la
p
re
s

printe
printe

imp
printe
printe
printe

unattended, 66
et, 79

, 65

4

rder of queued print jobs, 63
onfiguration screen, 26

rint head and paper cutter, 32
 job from the queue, 62
8
g, 65

38
7, 112
r, 23

es, 66
 space to print job folders, 68
ource folder, 44
x

Backnts Next Index

dding a logo to a page, 115
hoosing glossy or matte, 117
utting prints, 117
ying out the page, 111
ackage printing, 119
ystem requirements, 111
sing the Print dialog box, 113
iewing a summary of print settings, 114
DOWS 98 / ME, 105

utting prints, 110
isplaying the Properties screen, 105
ying out the page, 105
ackage printing, 107
DOWS XP / WINDOWS 2000, 95

dding a logo to a page, 104, 110
utting prints, 103, 110
isplaying the Printing Preferences screen, 95
ying out the page, 96
ackage printing, 100, 107
moving, 95

caling a page, 97
r identification, checking, 35
r model catalog
orting, 91
r model catalog, importing, 91
r names, viewing and changing, 34
r usage, checking, 37

printing
attended and 
calibration targ
forcing, 65
forcing printing
overview, 45
resuming, 65
suspending, 6

process
calibration, 77

R
rearranging the o
refreshing the C
registration

adjusting for p
removing a print
report, saving, 3
resuming printin

S
saving a report,
scaling a page, 9
selecting a printe
server preferenc

allocating disk
changing the s
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sele
sett
sett

setting
setting

cali
prin

sharin
(M

sharp
sourc
startin

Cal
Con
ML-
ML-
Prin

startin
startu
Status

Cal
s

Con
s

Prin
s

status

ing, 64
ents
s, 1
nd drivers, 5

ration target, 79

etting, 28
r calibration, 93

plication, 76
hiding, 76

pplication, 43
 hiding, 43

124

ing, 66
 checking, 37

 off, 21
x
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cting a startup state, 68
ing print queue limits, 68
ing up the log file, 44
 print queue limits, 68
s

bration, changing, 87
t jobs, 48
g the server’s source folder 
ACINTOSH), 18

ening images, 56, 118
e folder, selecting, 44
g
ibration application, 75
figuration application, 25
500 applications, 22
500 Utilities, 20
t Server application, 41
g point for calibration, selecting, 78
p state, selecting for print server, 68
 bar

ibration application, 76
howing or hiding, 76
figuration application, 26

howing or hiding, 26
t Server application, 42
howing and hiding, 42
 of printer and media, 36

suspending print
system requirem

ML-500 Utilitie
port monitor a

T
target. see Calib
test print, 38
time and date, s
tolerance level fo
Tool bar

Calibration ap
showing or 
using, 76

Print Server a
showing and
using, 43

troubleshooting,

U
unattended print
usage of printer,
Utility bar, 21

turning on and
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V
viewin

W
WIND

driv
in

sys
WIND

driv
in

sys
WIND

inst
WIND

driv
in

sys

X
XtraLi

sett
XtraLi
x
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g open applications, 23

OWS 2000/XP
er
stalling on the server, 10

tem requirements, 5
OWS 98/ME
er
stalling on the server, 12

tem requirements, 6
OWS drivers
alling on the client, 13
OWS NT
er
stalling on the server, 12

tem requirements, 6

fe option
ing (WINDOWS), 16
fe ribbon type, selecting, 30
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